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Warning Labels

The following warning and caution labels are utilized throughout this manual to convey critical information
required for the safe and proper operation of the hardware and software. It is extremely important that all
such labels are carefully read and complied with in full to prevent personal injury and damage to the
equipment.

There are four levels of special alert notation used in this manual. In descending order of importance,
they are:

DANGER: This indicates an imminently hazardous situation, which, if not
avoided, will result in death or serious injury.

WARNING: This indicates a potentially hazardous situation, which, if not
avoided, could result in serious injury or major damage to the equipment.

CAUTION: This indicates a situation, which, if not avoided, could result in
minor injury or damage to the equipment.

NOTE: This provides supplementary information, emphasizes a point or
procedure, or gives a tip for easier operation
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PreciseVision Machine Vision System

PreciseVision Introduction

PreciseVision is a powerful, full featured 2D machine vision software package. This software application
includes a complete toolkit with everything that is needed to acquire vision images, identify and locate
randomly positioned and oriented parts, measure key features and inspect parts for specific defects.
Each of the basic vision functions is provided as a type of "Tool" in the vision toolbox and is internally
designed as a modern software "Object".

PreciseVision executes on a Windows PC system and includes a built-in interface to communicate with a
Precise Controller via Ethernet. This software package has been designed to operate with the Guidance
Programming Language, which executes on a Precise Guidance Controller, to produce flexible vision-
guided motion applications. The Guidance Programming Language, GPL, includes a complementary
built-in communications interface to PreciseVision and has classes and objects for easily controlling the
operation of PreciseVision and retrieving vision results. A complete vision guided robot application
consists of a list of vision tools executing in PreciseVision and a GPL program executing on a Guidance
Controller that takes the vision results and utilizes this information to alter the actions of a robot.

PreciseVision includes a very easy-to-use visual programming interface that allows both simple and
complex vision programs to be constructed by dragging-and-dropping tools into a list. Training of the
tools is performed by visually positioning and sizing tools on top of a captured camera image. The
parameters for each tool can also be access via a "Properties Table". Since each tool is a software
object, the output of one tool can be easily linked to the input of other tools. This is a very powerful
capability that allows the placement and the actions of tools to be a function of the results of previously
executed tools and permits the results of several tools to be combined.

To capture an image, PreciseVision supports third party Ethernet and USB cameras. Vendor and part
number information for purchasing and installing recommended hardware and drivers are provided in this
document.

While the most common configuration is to have PreciseVision interfaced to a single robot, information is
also provided on executing PreciseVision without a robot or when connected to multiple robots.

In addition to the normal mode of executing tools on a real camera image, this package also permits a
sequence of images to be easily saved to disk and then subsequently played back. This allows vision
tools to be tested off-line and provides a convenient means for customers to obtain assistance from
Precise and its partner companies remotely.

In this document, instructions for installing PreciseVision and the supported 3rd party hardware is
presented. This is followed by an overview and quick start section that introduces machine vision
newcomers to PreciseVision's principal concepts and permits experienced individuals to quickly use the
system. Finally, the last sections of this manual provide detailed information on the system's user
interface, toolkit and camera calibration procedures.
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For further information on programming a vision guided robot application in GPL, please refer to the
Guidance Programming Language, Introduction to GPL.



Supported Hardware and Software Installation

Supported Vision Hardware

PreciseVision is a software package and does not include hardware. This software is designed to capture
vision images that are generated by either Ethernet or USB cameras. PreciseVision permits three camera
options:

1. DALSA Genie™ GigE cameras that communicate via a 10/100/1000 Ethernet
connection

2. IDS Imaging uEye™ cameras that communicate via a USB 2.0 connection

3. Other 3rd party USB cameras (No customer support provided)

Each of these options offers a range of camera resolutions, imaging element sizes and a choice of
monochrome or color image capturing. The DALSA and IDS cameras have many of the same industrial
features and a wide range of models are fully supported by PreciseVision. There are a host of other USB
cameras available that range from very inexpensive web cams, to astronomy cameras, to industrial grade
cameras, all with different prices, characteristics and installation procedures. Please contact Precise to
determine if a specific USB camera has been qualified with PreciseVision. Precise is not able to
provide support for USB cameras that have not been tested and qualified.

When using the standard version of PreciseVision, the system can connect to multiple DALSA cameras
or multiple USB cameras. However, you cannot connect to both DALSA and USB cameras
simultaneously. In the Multi-Instance version of PreciseVision, the same rule applies to each instance, i.e.
a single instance cannot be connected to a mix of DALSA and USB cameras. However, different
instances can be connected to either DALSA or USB cameras.

There are a number of trade-offs that should be considered when selecting the type of camera to use with
PreciseVision. The following table summarizes the trade-offs between the DALSA and IDS cameras.

Characteristic DALSA GigE IDS uEye USB

Typically 20% less expensive than
equivalent DALSA cameras. Non-

Cost Typically more expensive industrial 3rd party USB cameras can
be significantly less expensive.
640x480 up to 2560x1920 with even

Resolutions 640x480 up to 1600x1200 |higher resolutions to be announced

soon.

Very similar to DALSA for same

Very similar to IDS for same |resolution using USB 2.0 (480
resolution Mbits/sec). USB 3.0 (4.8Gbits/sec) due
in 2011 will reduce the requisition time.

Acquisition time

Hardware Supports trigger input and

T . Same as DALSA.
synchronization acquisition output
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Higher load relative to Ethernet
Reduced load relative to cameras. Multiple cameras will require
USB cameras a higher performance CPU. 5 or more
cameras may degrade acquisition time.

5M. Powered USB hubs might be able
to extend length

Limited by how many cameras can be
connected to and serviced by a PC
using hubs, maximum of 6 cameras
per PV instance. Adding cameras to a
port will reduce the pixel clock rate.

PC CPU Loading

Cable length 100M

Limited to 13-18 cameras
Max. number of  |per Ethernet subnet,
cameras per PC  |maximum of 6 cameras per
PV instance.

Typically easier for single cameras if
wired point to point since no firewalls,
less issues with USB hardware
interface, simpler driver installation.

Fewer steps but more prone
to complications due to
firewalls, Ethernet card
Installation and compatibility, Ethernet
support switch problems, and
somewhat more
complicated driver
installation.

Multiple cameras are a bit more difficult
to setup since each must be assigned
an ID and registered with the
DirectShow interface.

Simpler to install on Precise

Arm-mounted robots since Ethernet cable |Requires extra external cable for
cameras and power available at end- |Precise robots
of-arm

12VDC 4 watts provided in
second cable from extra PS

Size / weight 29x44x67 mm, <125g 34x32x34.4 mm, 759

Power 5VDC taken from single USB cable

In the following sections, part numbers are provided to allow hardware to be directly purchased from the
hardware vendors together with simplified wiring drawings that illustrate how the components should be
connected.

Option 1: DALSA Ethernet Cameras

e Each instance of PreciseVision supports up to 6 DALSA Genie™ GigE Ethernet
cameras. See the table below for the recommended/supported camera models.

e DALSA cameras can be directly connected to the PC running PreciseVision or
through an Ethernet switch.

e The PC must include a standard Ethernet card, but a GigE card is recommended
for the best performance.

e For more information, visit the DALSA website at www.imaging.com. For
ordering, contact Manish Shelat at DALSA Digital Imaging, phone: (510) 249-
5664, email: manish.shelat@DALSA.com.
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PreciseVision using DALSA Genie Camera

Ethe

Guidance
Controller

FPC with
Preciseivision

Senie Camera

Ethernet

Ethernet

Ethernet
Switch

met

Hardware Specification

ETHERNET
CAMERAS

PreciseVision fully supports a number of DALSA Genie GigE
Vision Cameras. All models listed below provide Progressive
scan, have metal cases, C-Mount or CS mount lens adapters, are
available in monochrome (M) or color (C), and support an external
trigger (DIN) and a digital output (DOUT). Effective frame-to-frame
time depends on the exposure time that ranges from 100
microseconds to 4 seconds, controlled via software, plus PC
overhead. For total time, add vision processing time, which is
typically less than 100ms. PreciseVision supports up to 6 DALSA
cameras.

M640-1/3, 640x480 resolution, 60 frames/second raw frame rate,
1/3" sensor.

M1024, 1034x779 resolution, 20 frames/second raw frame rate,
1/3" sensor.

M1400, 1392x1040 resolution, 15 frames/second raw frame rate,
1/2" sensor.

M1600, 1600x1200 resolution, 15 frames/second raw frame rate,
1/1.8" sensor.

MOUNTING
ADAPTER

Optional DALSA mounting bracket assembly, 1/4" screw mount,
part # CA-GENA-BRAQO. This bracket is used for mounting the
camera on a standard tripod.

CAMERA POWER

Each camera requires 4 watts, 11 VDC to 13 VDC.

Option 1: If you wish to break out the camera’s I/O pins, order
DALSA part # CA-GENA-PS120 and the DALSA Genie I/O and
power breakout cable assembly, part # CA-GENC-IOPOQO.

Option 2: If you do not need I/O signal break out, an alternative is
the Intercon PSISP10, which includes a connector compatible
with the camera but no 1/O signal break out,
www.nortechsys.com/intercon/index.html

ETHERNET
SWITCH

Standard GigE Ethernet Switch. Netgear GS605 10/100/1000, or
equivalent.

ETHERNET CARD

Standard GigE PC Ethernet card. Netgear GA311 PCI Gigabit
Adaptor, or equivalent.

ETHERNET CABLE

Standard Cat-5 Ethernet cable. Total of 3 required.
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Option 2: IDS uEye USB 2.0 Cameras

Each instance of PreciseVision supports up to 6 IDS uEye™ USB 2.0 cameras.
See the table below for the recommended/supported camera models.

IDS cameras are typically connected directly to the PC running PreciseVision
although a USB hub can be used.

The PC must support USB 2.0 (not 1.0) and must have DirectX 9 or higher
installed. PreciseVision uses DirectShow (DirectX) to interface to the camera
driver.

It is highly recommended that only uEye cameras that support "Global" shutters
be utilized and not "Rolling" shutters. A Global shutter exposes all of the pixels of
the imaging element at one time. A Rolling shutter exposes lines at different
times. This can result in smearing if there is any movement in the image.

For flexibility in selecting the appropriate lens for your application, a camera with
a C-Mount or CS-Mount is highly desirable.

PreciseYision using IDS uEye Camera

UEyE Camera
Powered by
LISE Cable

Guidance
Contraller

P with
Precisevision

Ethernet LISE 2.0

Hardware Specification

USB CAMERAS

PreciseVision fully supports the IDS Imaging Development
Systems GmbH uEye USB 2.0 Cameras listed below. All of these
models have Global Shutters, metal cases, C-mount lens
adapters, are available in monochrome (M) or color (C), DB9
signal/power connector, and support an external trigger (DIN) and
a digital output (DOUT). Effective frame-to-frame time depends on
the exposure time and PC overhead. For total time, add vision
processing time, which is typically less than 100ms. PreciseVision
supports up to 6 USB cameras.

Ul-2410-M/C, 640x480 resolution, 75 frames/second raw frame
rate, 1/3" CCD sensor.

UI-2230SE-M/C, 1024x768 resolution, 30 frames/second raw
frame rate, 1/3" CCD sensor.

Ul-2240SE-M/C, 1280x1024 resolution, 15 frames/second raw
frame rate, 1/2" CCD sensor.

Ul-2250-M/C, 1600x1200 resolution, 12 frames/second raw
frame rate, 1/1.8" CCD sensor.
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CAMERA POWER Power ||s supplied directly by the USB cable and is generated by
the PC's power supply.
USB INTERFACE PC must be equipped with USB 2.0 interface (not 1.0).
USB CABLE, IDS uEye industrial camera cable: High speed 2.0 Extension
TRIGGER cable - Screw type 4-Pin USB type A (F) TO 5-Pin micro-USB
SUPPORT, NO type B (M). 3 meter length. Cable breaks out trigger input as
DOUT separate input. CB-IDS-9UD-A-T-3M
Right angled trigger cable for uEYE-Cameras, 3 meter uEye Micro
USB CABLE, Sub-D connector, 90° angled with screws. USB signal via
TRIGGER AND shielded USB 2.0 cable to USB-A. Breakout cable for trigger input
DOUT SUPPORT and digital output, cable with open ends. CB-IDS-9UD-A-ST3M-
RT

Option 3: Other 3rd Party USB 2.0 Cameras

There are a wide variety of 3rd party USB 2.0 cameras that are available for the home,
hobbyist, commercial and industrial markets. Due to the large number of vendors, their
different installation procedures and their individual idiosyncrasies, Precise cannot
guarantee that any camera brand that you select will work properly and we cannot provide
assistance for any camera that has not been tested and qualified by Precise.

Nonetheless, if you wish to interface an unsupported camera without Precise's assistance,
please consider the following when selecting a USB camera.

. PreciseVision utilizes DirectShow to interface to the camera. Therefore, the USB
camera must be compatible with DirectShow, which is quite common.

. PreciseVison's image acquisition tool has been specially optimized for the IDS
uEye family of cameras. Other USB cameras will take somewhat more time to
acquire an image.

. For similar features, a camera in a plastic case will be less expensive that a
camera in a metal case. You must determine if the additional ruggedness of a metal
case is important for your environment.

. Many inexpensive cameras utilize the standard USB connectors that are retained
by friction. It is relatively easy for these to become accidentally disconnected as
compared to screw in DB connectors such as those used in the IDS uEye cameras.

o Many inexpensive cameras either have integrated fixed lens or lens mounts that
do not support the full range of lens that are available. Also, many lens do not have
screws for locking in the focus or F-stop adjustments.

. Most cameras do not have trigger inputs and digital outputs. These are important
features for conveyor belt tracking and other real-time image capture requirements.
Also, since communication standards have not be established for these features,
even if the camera has these hardware features, PreciseVision will probably not be
able to access this capability.

Installing PreciseVision on a PC

PreciseVision is distributed as a standalone application that executes on a Windows PC system. For the
best results, it is suggested that this software be executed on the following equipment:

e 2.3Ghz or faster Pentium 4 PC running Windows XP
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o Depending upon the type of cameras to be utilized:
0 Gigabit Ethernet (recommended and required for certain cameras),
otherwise 100Mb Ethernet interface
o0 USB 2.0 interface
e 512 MB of RAM
e Atleast 1 GB of space on the PC's disk
e A 2x CD-ROM drive interfaced to the PC

While PreciseVision can be executed by itself to develop Vision Processes, the PC must be able to
communicate with a Precise Guidance Controller via Ethernet in order to run a complete vision-guided
motion application. Please see the “Guidance System Setup and Operation, Quick Start Guide” for
instructions for configuring the PC and the Guidance Controller to communicate with each other.

If you previously installed PreciseVision on your computer, you should un-install the old version by
performing the steps below. If you are installing PreciseVision for the first time, you can skip the first set of
instructions.

» Shut down all programs that are running including virus protection programs.

» Bring up the Window's Control Panel by clicking “Start > Settings > Control Panel”.

» Double click on the “Add or Remove Programs” selection.

» In the “Add or Remove Programs” popup window, scroll down and click on “PreciseVision”.

» Click the “Remove” button and click on “Yes” to confirm the action.

N

» Close all of the windows that you opened.
To install PreciseVision on your computer, perform the following steps:

» Shut down all programs that are running including virus protection programs.

» Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive. A panel should pop
up that welcomes you to the Setup Wizard. If the installer does not automatically start, click
“Start > Run”, type in “D:\setup.msi” (where D is the CD-ROM drive), and click “Ok”.

» Follow the instructions in the Setup Wizard to install PreciseVision. Note, PreciseVision
relies upon the Microsoft .NET Framework in order to operate. This is a standard module that
Microsoft provides free of charge. If the Setup Wizard detects that this module is not available,
you will be asked if you wish to install the Framework now. You should respond "Yes". This
will launch a browser to take you to the download site for the required software.

At the conclusion of this process, PreciseVision will be installed on your PC. This software by itself is
sufficient to execute PreciseVision with camera images that have already been captured and saved to a
disk file. But, to operate this software with a camera, one of the camera interface installation
procedures in the following sections must be performed. In addition, in order to continue to use
PreciseVision beyond the trial period, you must register this product with Precise Automation. The
registration process is described in detailed in a following section.
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Installing and Configuring the DALSA Genie™ Camera
Interface

If your system is equipped with a DALSA Genie™ GigE camera, the procedure described in this section
must be executed to interface and configure this device. If your system does not use this camera, please
skip to the next section of the documentation.

Prior to executing this procedure, ensure that the following requirements are satisfied:

e The DALSA Genie™ camera must be interfaced to the PC via a 100MB or
1000MB (Gigabit) Ethernet card. A 1000MB card will produce the best
performance although a 100MB card will produce acceptable performance for
many applications.

The first step in the process is to install the DALSA device driver and its configuration software.

» Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive.

» Inthe "DALSA/SaperalLT/" folder, double click "Setup.exe" to execute the installation
procedure.

» Follow the instructions in the Setup Wizard to install the driver.

» Inthe "DALSA/Genie/" folder, double click "Genie_1.nn.nn.nnnn Release.exe" to execute
the installation procedure.

» Follow the instructions in the Setup Wizard to install the driver.

» After installing the Genie drivers, the PC must be rebooted.

After rebooting the PC, you should see a small camera icon. in the task bar in the right hand corner but
with a red ‘X’ over it.

Plug the Genie camera into the network. After a period of time the ‘X’ will disappear. If you hover over the
icon, the tool tip will indicate the number of Genie cameras that have been located. If no cameras are
located, please see the following "DALSA Genie Installation Trouble Shooting" table.

DALSA Genie Installation Trouble Shooting
Trouble Possible Solutions

When the PC bOOtSﬁ itis not |The Genie driver did not properly install. If you have
displaying the little .2® camera |VPN software installed, try removing this and re-
icon in the system tray. installing the Genie driver.

If you have multiple network cards, try opening up the
‘DALSA Network Configuration Tool’. This is found in
"Start -> DALSA -> Sapera Network Imaging
Package".

The camera . icon is
displayed but always has a red

X" over it™a. Select the "Network" Adapter you are using with the
camera. Select the "DHCP/LLA" mode in the Device
Configuration section.
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If vou are still having difficulty with the operation of your DALSA camera, please see the FAQ
chapter of this manual for additional step-by-step trouble shooting instructions.

Verifying the Camera Firmware is Up-to-Date

At this point, the basic camera driver installation is completed. However, it is possible that the firmware
that shipped with your DALSA Genie camera may not match the PC driver that you just installed. If the
firmware and the driver do not match, the camera may not operate reliably. To determine if the camera
firmware needs to be updated, perform the following steps:

» Ensure that the camera is properly communicating with the PC per the instructions above.

» Open the DALSA Device Manager firmware update dialog. This is accomplished from the
Window's Start menu by clicking: "Start > Programs > DALSA > Genie > Firmware Update".

A list of available cameras will be displayed as shown in the following picture.

DALSA Device Manager

DAL SA Dewvice Mansges
Verson: 268

Sedect " Automatic " to update vath the D efault Configuation
Selact " Maniial " to updsts with a Specific Conliguiation

Boaid Senial Humbei Configuration Update
camaral :Gerss_MEBA0_1 53189281 Monochiome Required
L4 >

Automatic | M anual Carcel

The right most column labeled "Update" indicates the firmware status of each camera.

» If the "Update" status is "Not Required", the camera firmware matches the driver and the
following steps can be skipped.

» If "Required" is indicated, the camera firmware must be updated for proper operation. To
update the firmware, click on the "Automatic" button.

» Allow up to 3 min. for the camera to update. Do NOT unplug the camera during this time.

» After the camera re-initializes the LED on the camera next to the power connector should
return to a solid BLUE state. This indicates that the process is completed and you can now exit
from the DALSA Device Manager.

Selecting Ethernet Cameras Instead of USB Cameras

10
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PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration mode
without a camera. However, at any given time, only one camera type is permitted for each instance of
PreciseVision. The first time PreciseVision is executed after being installed, it prompts for the type of
camera to be used. Thereafter, the camera type is remembered until it is explicitly changed. The
following procedure can be used to change the camera type or to verify that PreciseVision is properly
configured to capture images from the correct type of camera.

» Launch PreciseVision by selecting " Start > Programs > Precise Automation > PV_ >
PreciseVision".

» Open the Preferences pop-up by selecting the following within PV: "File > Preferences"
and open the "Camera Hardware" tab.

» Ensure that the "Genie (Dalsa Ethernet Camera)" option is selected.

» Restart PreciseVision if the selected camera type is changed.

Vision Graphics | Result Settings | Live Video | Layouts | User Access |
Ao Start | Ervironmmert  Camera Hardware | \eb Interface | Client Settings | Aequire |

Select camera hardware bo use by Precisel/fision.

W H
" Mare [dema mods) Frame Size IW | 480
" Ditect Show (USE] DS Mapping
* Genie [Dalza Ethemel Camera) Gerie Mapping
Custom Config | Browse

[ Farce all buffers to be color.

1 Tne [in sec) bo wait for camens hardware o become svadable [-1 = nowat]

Details [ Prompt for camera selection durng startup

Cancel Update

Assigning (Mapping) Dalsa Cameras

The first time the DALSA Genie camera option is selected, PreciseVision will automatically scan for all
available Genie cameras. When a camera is located, the camera list will be created. Each located
camera is automatically assigned a camera number and will be identified by its MAC ID. The MAC ID is a
unigue number that is permanently assigned to every Ethernet compliant hardware component in the
world.

» To view the available Genie cameras and their assigned camera numbers, while still viewing
the "Camera Hardware" tab as described above, click on the "Genie Mapping" button.

11
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r @l
Accept 1-6 l Ignu:ure1-l3] lgriore ?-12]

Enable
Accept Camera MAC Address  Binning

1. [00-01-00-11-02-91 - Clear

2. [00-0-001-02-91 v Clear

3 [ Clear

4. | | Clear

5. | | Clear

B | [ Clear

|Jpdate | Cancel |

Up to 6 Genie cameras can be "Accepted" for use by each instance of PreciseVision. Once the Genie
camera list is created, a user can manually copy and paste MAC ID’s to change the camera order. To
have the changes take effect, PreciseVision must be restarted. Each time PreciseVision is started, the
physical cameras will be assigned to the same logical camera numbers based upon the contents of this
table and the camera’'s MAC ID numbers.

When PreciseVision is restarted, if a new camera is found on the network, the new camera will
automatically be assigned to the first available slot (logical camera number).

If a camera is disconnected or powered down, the slot for this camera is NOT cleared. This is important
since there are unique calibration files for each physical camera and vision applications expect to take
pictures using specific cameras.

With the Genie camera, it is possible to assign the same camera to several camera slots. This allows
different calibrations for the same camera if needed.

For a single camera configuration, simply start PreciseVision and the camera will be assigned to the first
camera slot and can be referenced as logical camera #1.

Camera "Binning"

For DALSA cameras, the system supports "binning". At the camera hardware level, this process
combines every other pixel horizontally and vertically and returns half of the standard number of pixels in
each row and only every other row of pixels.

This process has the advantage of increasing the contrast in an image in the same manner as averaging
two images. Also, since there are fewer pixels transmitted by the camera, the image acquisition time is
reduced. However, the acquisition time is not reduced proportionally to the reduction in pixels. Although
there are only 1/4th the number of pixels, for a 640x480 camera the speed improvement is only a few
percent and for a 1392x1040 camera the speed improvement is approximately a factor of two. This is
because the camera performs the vertical binning in the analog domain, which results in a 2x
improvement, but the horizontal binning is performed in the digital domain so all pixels in a row are still
sampled. In addition, there is some overhead that further reduces the speed improvement. Nonetheless,
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for high resolution Dalsa cameras, binning can be used to reduce the image capture time when lower
resolution is acceptable.

» If you wish to turn on binning for a camera, in the "Genie Camera Mapping" panel shown
above, check the "Enable Binning" next to the camera's MAC address.

» If you wish to access a camera in both full resolution and binning mode, in the "Genie
Camera Mapping" panel, copy the MAC address to another logical camera number and
enable binning on one of the logical cameras for the same physical camera.

» PreciseVision must be restarted to have any changes take effect.

Whenever a logical camera with binning enabled is accessed, binning will automatically be performed.

When binning is turned on for a camera, the camera calibration for this logical camera must be re-
computed. This is required since the pixel to mm scale factors will have changed.

Releasing DALSA Cameras to Other PreciseVision Applications

For multiple cameras on the same Ethernet network that are accessed by a different PC or for cameras
that are accessed by a different instance of Multi-Instance PreciseVision on the same PC, there is an
ignore list. Cameras that are listed as one of the "Ignore" entries are released from the current
PreciseVision and available for use by other copies of PreciseVision.

» If you do not wish to utilize a camera within the current PreciseVision application, cut and
paste the camera's MAC ID from the "Accept" list to the "Ignore" list.

» PreciseVision must be restarted to have any changes take effect.
Accept 16 lgnore 1-6 l |gnore ?-12]

|gnore Camera MAL Address
. |IZIIII-EI'I -00-11-04-E3 Clear

—_

Clear

Clear

3
. | Clear
3
3

Clear

L= B ) B T B ]

Clear

|pdate Cancel

This completes the DALSA Genie™ camera setup. PreciseVision can now acquire camera images via
this camera(s).
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Installing and Configuring the IDS uEye™ USB Camera
Interface

If your system is equipped with an IDS uEye™ USB camera, the IDS uEye device driver must be installed
and the camera must be configured. PreciseVision utilizes DirectShow and the IDS driver to communicate
with the camera. If your system does not use this type of camera, please skip to the next section of the
documentation.

Prior to executing this procedure, ensure that the following requirements are satisfied:

o Initially, it is preferable if your IDS camera is NOT connected to the PC. After the
IDS driver is installed, the camera can be attached and the PC will automatically
discover the camera.

The first step in the process is to install the IDS USB device driver and its associated configuration and
diagnostic software.

» Insert the PreciseVision CD-ROM into your computer’s CD-ROM drive.

» Inthe "uEye" folder, double click "uEye32_xxxxx.exe" to execute the installation
procedure. If your computer contains a 64bit version of Windows, then visit the IDS web site to
download the 64bit version of the driver.

» Follow the instructions in the Setup Wizard to "Install driver". When asked what type of

installation should be performed, select "USB". You should NOT install any Ethernet or
custom drivers.

At this point, the required system driver and the support software have been loaded and installed.

Assigning ID's to Multiple uEye Cameras

For Ethernet cameras, each camera's Ethernet MAC ID uniquely identifies the camera and is used to
associate each camera with the same vision operations whenever PreciseVision is restarted.
Unfortunately, USB connections do not have a similar identification mechanism. So, to ensure that the
correct cameras are associated with vision operations, a unique camera ID must be stored into the
NVRAM of each IDS camera.

The camera ID ranges from 1 to n and is automatically added to the name of each camera. For example,
if the ID is set to 3, the camera will be identified as "uEye Capture Device 3".

» Plug the uEye cameras into the PC. This will permit the PC to discover this new hardware
and configure the cameras for use.

» Execute the uEye demo software to verify that the cameras are functioning property. Select
the demo software by RIGHT clicking: " Start > Programs > IDS > uEye > Samples > ukEye
DirectShow Demo".

» In order to gain access to key properties when executing the demo software, click "Run as",
then select "The following user:" and "Administrator".
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w|  [raphstate: STOPPED
[ Start Graph | [ Firi Propertis: |
’ Pause Graph | I Filter Properties |
[ Stop Graph l ’ Dump Graph ]
Sat exposura time [usl [ Auo
& T334 133741
Frame rats: F.20

In order to receive a clear indication that the camera is properly interfaced and to permit changing the
camera ID's, the automatic registration mode of the camera must be disabled.

» In the main panel for the demo program, set the "active video source" to the camera of
interest and press the "Filter Properties" button to display the panel below.

» Uncheck "Use automatic registering"”, press "Ok", and exit the demo program.

uEye Caplure Device Filter Properties

Image Palameter: Image Froceszng Trigged/Flazh
Color Seitings | Device | Misc InpeatDnkput
Camera
Camera model: LI 2L
Sarial Mo, : 4002910925
Mative resolubion; 12800 1064
Frames received: | o Frames dropped: 0
Load/Save locataon:; -d'spia;.- file selection bax »
| sawesemings | [ LosdSettings | [ Ressttodefauks |
Inkarface

Changes may take no effect without restarting your applcation!
[(Juse botton-up inages

[use automatc registering

[JUse camera names

[ ok || cCocel |

If you only intend to connect a single USB camera to your PC, you can skip to the next section since the

cameras default ID of 1 can be used.
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» To assign camera ID's, execute the uEye Camera Manager by clicking on " Start >
Programs > IDS > uEye > uEye Camera Manager".

[ﬂ uEye Camera Manager - 32-Bit

Camera lisk

Fras Avail. Type <CamJD Dev.]D Modsl Serho,

Control center
[CJExpert mode
| Generalwformstion | | comeravformation |
| cestesppotfie | | ETHnetworkserviee |

| addwional functions | Automa

By iDS:

™= Engish v

Close |

Skatues of device Nr, 1: The camers is configured comrecthy and can be opened.

i

» Select a desired camera by clicking on a line in the Camera List and click "Camera
Information".

Camera information

Deevice I0: 1

Marufacturer Diake of QC

| | |
Camera 1D User EEPROM {max, 64 characters)

@] |

| coneat || oK |
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» Change the "Camera ID" to a unique number. These should be assigned so there are no
gaps in the numbering (1,2,3,..).

» When completed, click "OK" and close the Camera Manager when done.

Before PreciseVision can discover multiple USB cameras, they must be registered using the uEye
DirectShow Capture Device Manager.

» To register each of the IDS cameras, click "Start > Programs > IDS > uEye > DirectShow
device manager".

uEye DirectShow Capture Device Manager

Direckshow Davice | Camara-1D 1 Model | Sarflo |
uEve Capbura Device 1 1 /A &
uEve Capbure Device 2 2 A T
uEya Capbure Device 3 3 UIZ235E-C 4002715329

add device remave device | Ok | Cancel

» Clear the list by clicking on "remove device" multiple times.
» Populate the list by clicking on "add device" a number of times until the highest camera ID

that you have defined is listed. If the camera ID's were not sequentially assigned, there can be
N/A placeholders as shown above. This will not create a problem.

Selecting USB Cameras Instead of Ethernet Cameras

PreciseVision can operate using either Ethernet cameras or USB cameras or in a demonstration mode
without a camera. However, at any given time, only one camera type is permitted for each instance of
PreciseVision. The first time PreciseVision is executed after being installed, it prompts for the type of
camera to be used. Thereafter, the camera type is remembered until it is explicitly changed. The
following procedure can be used to change the camera type or to verify that PreciseVision is properly
configured to capture images from the correct type of camera.

» Launch PreciseVision by selecting "Start > Programs > Precise Automation > PV_ >
PreciseVision".

» Open the Preferences pop-up by selecting the following within PV: "File > Preferences"
and open the "Camera Hardware" tab.

» Ensure that the "DirectShow (USB)" option is selected.
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» Restart PreciseVision if the selected camera type is changed.

Vision Eraphh::s| Result Seltings | Live Video Lay-:vuts| Lizer A-cn:haas]
Auto Start | Ervironment  Camera Hardware | web Inteiface | Client Seltings | Acquire |

Select camera hardware to use by Precisel/ision.

W H
™ Mone [dema mode] Frame Size IW IW
% Ditect Show [USB) DS Mapping
" Gerie [Dalsa Ethenet Camera) Gerie Mapging
Custom Corfig | o

[ Force all buffers ba be colar.

1 Tine [in sec] to wait for camera hardware to become avalable [-1 = nowait)

Details [ Prompt for camera selection dumng startup

Cancel Update

Assigning Cameras, Selecting the Camera Resolution and Display Mode

When the PC boots or whenever a USB camera is connected or disconnected, Windows automatically
assigns each camera an index in a list of cameras. The ordering of the cameras is dependent upon the
USB interface to which they are connected. For a given configuration of cameras, the index of each
camera will always be the same. However, if a new camera is connected, it will not necessarily be added
to the start or the end of the list.

Unlike Ethernet cameras, USB cameras typically have several different formats that can be used to
retrieve the image data at different resolutions. The formats that PreciseVision and its DirectShow
interface support include the following:

RGB8 (8-Bit Grayscale)
RGB24 (24-bit color with 8-bit R,G,B components)
YUY2 (16-bit color)

When PreciseVision is started, it retrieves information on all of the connected USB cameras and
automatically assigns them to a logical camera buffer and selects a format with the highest resolution.
PreciseVision permits these automatic assignments to be manually over-written.

To review or change the current camera assignments and settings, perform the following.

» While still displaying the PreciseVision "Preferences" pop-up, and viewing the "Camera
Hardware" tab (as shown above), click on the "DS Mapping" button.
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USE Camera Mapping X

M apping ]

Cam Direct Show D DS Camers

Buf Enable Resolutian Idx«  Mode Bulfer Type
1 ¥ Crealive'WebCamLivel | B406480 [ 0 | 4 B IsColor Select |
2 [ uEyeCaptueDevice3 | 1024x768 [ 1 | 0 ¥ IsColer Salect |
3 [~ Unassigned | |1 T isColar :
4 [ Unassigned | | | I& .
5 [ Urnassigned | | | Im
B [ Unassigned | | | Im

Concel_|[_upste |

For each discovered USB camera, this panel displays the logical number (Camera buffer) that it has been
assigned, together with its resolution and format, and the index number that Windows has automatically
assigned. The "Enable" checkmark indicates that a camera will be exclusively used by the current
instance of PreciseVision.

» If the Multiple-Instance version of PreciseVision is being executed, a camera can be
released for use by another instance by unchecking "Enable" and restarting PreciseVision.

If you wish to assign a camera a different logical camera number or change its format and resolution, do
the following.

» While still displaying the USB Camera Mapping panel, click on the "Select" button for the
camera of interest.

Select From Available DirectShow Cameras =)

DiractShow Camaraz Datactad Camera Hezolubon Irdormation
{1 Craatve WebCam Lival #3 Mode = Reschution | Bt Count| SubType
0 1024 = 768 24 RGE 24
1 1024 x 768 8 G-bit grayscale

Pick the camera to use and the resolution. Chck
Celacl' to use these sattings.

Cancel Select
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If you wish to access the same camera in different formats or want to utilize more than one set calibration
data, the same camera can be assigned to multiple logical camera/buffer numbers.

Subsequent Changes in Camera Assignments

If a USB camera is disconnected or a new camera is connected to the PC, the next time that
PreciseVision is started, the Windows camera index numbers can all be changed. If a camera name is
unambiguous, as is the case for IDS cameras that have been assigned unique camera ID numbers,
PreciseVision attempts to assign the cameras to the same logical camera number/buffer as the last
session independent of their Windows index number. If camera names are not unique, PreciseVision
utilizes the Windows camera index numbers to determine their logical camera numbers. At the end of this
process, if the camera mapping has changed relative to the previous session of PreciseVision, the
following message is displayed to alert you to a possible problem.

Hardware Detection Mismatch E|

@ The USE cametra hardware configuration has changed, This could indicate ane af the Fallowing:

1. The name or ID of a camera has changed.

2, 0n a mulkiple camera configuration, one of the cameras is no longer plugged in,
3. A camera is plugged into a different port causing the mapping order to change.
4, A new camera has been discovered which caused the mapping order ko change.

Check the hardware for proper connections and restart Precisevision or
qn ko 'File - Preferences - Camera Hardware and adjust the DireckShow camera setup,

» If the error message above is displayed, review the USB camera assignment by going to
"File > Preferences > Camera Hardware > DS Mapping" and correcting any errors.

This completes the IDS uEye USB configuration setup. PreciseVision can now acquire camera images
via this camera(s).

Activating PreciseVision

To begin using PreciseVision, you must start the application on the PC.

» To launch PreciseVision, click on "Start > Programs > Precise Automation > PV xxx >
PreciseVision". The first time PreciseVision begins execution, you will see the following

popup.
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i ﬁ.

'T You hawve not vet activated Precisevision.
L

There is only 30 days unkil this product will become disabled,

would wou like bo activate the product nov?

Yes Mo

The license that you purchased for PreciseVision permits you to use this software to build and execute
Vision Processes on a single PC. To complete the software activation process, you must send
information concerning the PC to Precise Automation. To allow time for sending the information and
receiving a reply, PreciseVision is fully functional for 30 days without being activated.

If for some reason, you do not wish to initiate the activation process now, this popup will be displayed
each time you start PreciseVision. To re-display the activation popup from within PreciseVision, click on
"Help > Product Activation".

» To initiate the activation process, click "Yes" in the popup above. This will display the
following activation popup.

Product Activation *Not Activated® x|
— Computer 1D
|SGF4—ECE2—9':IEE—94C1 Copy I
— License Key
I Activate
Help | Cloze |

This popup displays the "Computer ID" that you need to submit to Precise as part of the activation
process.

» To obtain a license key to activate PreciseVision, please send an email to Precise
Automation that contains the following information:

To: sales@preciseautomation.com
Subject: PreciseVision License Key Request

Customer Name: <your name here, optional>
Customer Company:  <your company nhame here>
Telephone Number: <your phone number here, optional>

PreciseVision Serial Number: PV S0-0XXX-XXXXXX
Computer ID Number:  XXXX-XXXX-XXXX-XXXX
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» You can obtain the PreciseVision Serial Number from the PreciseVision License Certificate
that you received with your order. Below is a picture of the top portion of a typical PreciseVision
License with the serial number circled in red.

l P R E C [ S E T27 Filip Road, Los Altos, California 34024
AUTOMATION

PreciseVision™ PC
Single Right-To-Use Binary Software License Certificate

Serial Number:{ PVS0-000¢-1x0XXX

Thank you for purchasing PreciseYision™ PC. This product 15 a PC based application that
provides a powarful get of Lools to oplically locate, maasure and inspect a wide vanely of pars
uzing Ethernet cameras, A Precise Automation Guidance Comtrofler can directly communicata
with PreciseVision wia a high speed Etharmet connection, retneve tha wision results and wlilize
them to avtomatically adjust part pesitions and onentations. This lcense! permits one copy of this
binary software to be mstalled an a single PC

Dear Customer,

» The Computer ID number should be copied from the Product Activation popup.

» As a convenience, if you are viewing this help in the Precise Documentation Library, you
can click on the following link to get an email template: sales@preciseautomation.com.

» Alternatively, if you do not have email access, please Fax this information to 408-516-8348
together with your own fax number.

Your name and your phone number are optional. However, we recommend that you provide this
information in case there is a problem with your license and we need to get in touch with you. A sample
email should look as follows.
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Subject:  [PreciseVision License Key Request

Customer Mame; John Doe ;I
Customer Company: Acme Automation
Telephone Number: 1-408-555-5555

PraciseVision Serial Mumber,  PYWS0-0604-100001
Computer 1D Mumber: S0F4-3CE2-90CE-94C1
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In response to your request, you will receive a license key.

» When you receive your license key, access the Product Activation popup by restarting
PreciseVision or clicking in the PreciseVision menu item "Help > Product Activation".

» Enter the license key in the "License Key" box and press "Activate".

PreciseVision is now activated.

Configuring Communication Between the PC and the
Controller

In order for PreciseVision to exchange information with a Guidance Controller, each system must know
the Ethernet IP address of the other unit. During normal runtime execution, the Guidance Controller
initiates all communications and so it must know where to send its commands. During the Robot Vision
Camera Calibration procedure, PreciseVision needs to know where to send its commands to read the
current robot position.

Confiquring PreciseVision to Read Positions from a Controller

To permit PreciseVision to query a Guidance Controller for the current position of the robot, the IP
address of the controller must be defined in the system Preferences.

» Launch PreciseVision by clicking on "Start > Programs > Precise Automation > PV xxx >
PreciseVision".

» Open the panel for setting the controller IP address by selecting "File > Preferences >
Client Settings".

The panel for setting the IP address should resemble the following:

Preferences |

Camara Haidwane | Acoue |
Auto Start| Result Setfings  Clent Setlings | Enviorment | Vision Graphics |

Entes the [P addieszs of the controlier that 15 used dusng e calibration
piocess. The speciied |P sl b used to recond robot L

IF hddress |

Canceal Update
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» Enter the Guidance Controllers Ethernet IP address and press the "Update" button.

Configuring a Controller to Send Commands to PreciseVision

Whenever the Guidance Controller issues a command to PreciseVision, the controller automatically
establishes an Ethernet connection utilizing an IP address that is specified in the controller's Parameter
Database. This database is stored in the controller's flash disk and is preserved even if the controller is
turned off and restarted. To modify this database value, perform the following operations.

» Please see the “Guidance System Setup and Operation, Quick Start Guide” and follow the
instructions for bringing up the web based Guidance Operator Interface for the controller.

» In the web interface, open the database page for the vision IP address, "Setup >
Parameter Database > Controller > Network > Vision IP ".

The web interface page should look like the following:

2 Setup - Windows Intermet Explorer o] =]
@"_' w [B nipomzagan 3=
PRECISE ;
| AUTOWATION System: PreciseFlex 1400

“Control Fansls etup THotionBlocks TiEtes " lpelication web Tlogoul THein

=
Fabuct ke [Fooo 1 =]

Syutam Eetup .
% Wizards and Setup Tool Had = Brigh pows merk ke sl Pararatad vibs

Paramelber nama Bobets |, Slnko Phasnis Paims

fHcdmbrg Tufung S0 Labpn 424 | Viskso parowr [P addean I'.:l: HL =R H

= Faramater Databees

Cancel cuangay J Bat nam uadias Buen Al 1o Flass J

T Cosnrelber

a0

Opersting mods
Debug ard race
B Bagrinl Pty
= Matwers
Teinet
Cantrulle 1P
it 153

SErve Metwors

FTF U Paddword ]
ViRt Seturty
Cther Networi
St D0
il MaaBuy TOR

EtFarfialki]F

A Irmrroc AT | ibhw - o

» Enter the IP address of the PC executing PreciseVision into the value for the "Vision server
IP address (DatalD 424)".

» Press the "Set New Values" button to store this setting into memory.

» Press the "Save All to Flash" button to store this setting in the flash disk. This ensures that
this setting will remain in effect if the controller is restarted. The button will flash for 10-30
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seconds as the data is being written. DO NOT TURN OFF YOUR CONTROLLER WHILE THE
BUTTON IS BLINKING SINCE THIS MAY CORRUPT THE FLASH DISK.

The controller is now setup to send commands to PreciseVision. It is not necessary to restart the
controller.
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PreciseVision Overview

This chapter introduces PreciseVision's principal concepts, terminology and features. For newcomers to
machine vision, this chapter will provide background information prior to reading the detailed descriptions
contained in the following chapters. For individuals with experience applying machine vision, the
information in this chapter should be sufficient for you to start using the system.

PreciseVision has been designed to operate in combination with a Precise Guidance Controller and its
embedded Guidance Programming Language (GPL) to easily produce flexible and powerful vision-guided
motion applications. The following diagram illustrates the key software components in a vision guidance
application.

Initiate Vision Process
-

/%\ Read Tool Results
>

PreciseVision Vision Project GPL Robot Project
Vision Procass Vision Class
Vision Tool VisReasults Class
Tool Properties GPL Module
Vision Tool .

Tool Properties ]

Vision Process \_/

In PreciseVision, each fundamental vision runtime function is represented as a type of "Vision Tool" and
the collection of all possible types of tools is referred to as the "Vision Toolkit". For example, the
function that captures a picture from a camera and stores the result in a frame buffer is the "Acquisition
Tool"; the operation that fits a line to a set of edge points is the "Line Fitter Tool"; and the function that
uses an advanced, patented algorithm to identify and locate parts is the "Finder Tool".

To perform an element of a vision application, any number of Vision Tools can be combined into a
"Vision Process". Normally, an Acquisition Tool is the first tool in each Vision Process. This is followed
by one or more tools to perform part location, metrology or inspection operations. Multiple copies of the
same type of tool can be included within the same Vision Process. The individual characteristics of each
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tool (i.e. its size, position, algorithm parameters) are stored in Object "Property Lists". After atool is
executed, its output data is stored in its Property List in a "Tool Results" section. To simplify their
definition, tools can be positioned and sized by dragging their graphical handles on top of the display of a
camera image.

A Vision Process is the basic unit of execution that can be controlled by a GPL procedure. Using a built-
in "Vision Class", a GPL procedure running on a Precise Guidance Controller can start the execution of
a Vision Process in PreciseVision via Ethernet and monitor its progress. When the Vision Process
completes execution, the GPL procedure can retrieve the Tool Results of any tool within the executed
Vision Process by accessing the built-in GPL "VisResults Class". In applications where PreciseVision is
not connected to a Guidance Controller, another program executing in the PC or on another processor
can be used to trigger a Vision Process and retrieve the results (see the appendix that describes Remote
PC Control for additional information).

In most cases, only a single Vision Process is executed in order to perform the complete machine vision
task. Typically, this Vision Process will take a picture and then utilize Vision Tools to locate a part and
validate some key features or dimension. However, if a more complex machine vision operation is
required, a GPL procedure can execute any number of Vision Processes. For convenience, multiple
Vision Processes can be stored in a "Vision Project" in PreciseVision. At any given time, only one
Vision Project can be loaded into PreciseVision and only one of its Vision Processes can be executing.

In order for PreciseVision to return Tool Results in meaningful units, e.g. millimeters, and in an
appropriate coordinate system, any camera used for vision guidance must first be "Calibrated”. As a
convenience, PreciseVision includes a number of "Camera Calibration" methods that are described in a
later section. Once a camera is calibrated, all data retrieved by a GPL procedure via the VisResults
Class will be in millimeters and in the world coordinate system of the robot.

In a typical application, a single copy of PreciseVision will be executed on a PC and will be connected to
a single robot or motion controller. If you wish to provide vision results to a number of robots or motion
controllers, please see the appendix that describes Multi-Instance Execution.

In the following sections, the Vision Tools are briefly described along with the methods for creating and
editing Vision Projects, Vision Processes, and tools with their associated Property Lists.

Vision Toolkit Summary

In order to effectively analyze images, PreciseVision includes a full set of vision tools for acquiring
images, locating and identifying parts, performing metrology operations and executing visual inspection of
key features. In this section, the function of each tool is briefly summarized and a picture displaying how
the tool appears on the Camera Display Window is presented.

An important feature of PreciseVision is that the output of one tool can be easily utilized as the input for
another tool. For example, after the Finder Tool locates one or more parts, a tool that measures the
distance between two edges can be easily placed relative to the located part. This measurement tool can
then test if a critical dimension of the part is within the desired tolerance. Since this measurement is
performed relative to the output of the Finder, it will operate correctly even if the part's position or
orientation changes. Furthermore, if the Finder locates more than one part, the measurement tool will be
automatically applied to each located part. This ability allows complex measurements and tests to be
easily built-up from the basic tools that are provided.
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For a complete description of each tool, please read the "Vision Toolkit" chapter. (Note: The algorithms
for the complete set of tools has been developed and will be released in future upgrades to PreciseVision
during 2007. If you cannot find a tool that you require, please contact Precise Automation.)

Graphical Display Vision Tool Description

Captures an image from a camera or loads
N/A Acquisition Tool it from a disk file, and stores the image into
a frame buffer.

Searches a specified region for arc edge
points and returns the arc or circle that best
fits the edges. Returns both the arc center
point and radius.

Arc Fitter Tool

Copies a rectangular area-to-interest to a
disk file, another region of the current image
buffer, or another image buffer. Permits
mathematical manipulation when copying to
an image buffer.

rea-Of-Interest
AOI) Tool

Reads a variety of standard 1-D and 2-D
Barcode Reader Tool barcodes and returns the barcode type and
the value of the barcode.

Verifies that there is no obstruction within
the bounds of a defined window. Typically
used to confirm that gripping a part will not
result in a collision.

Clear Grip Tool

Searches a specified region for binary blobs
and returns the centroid and other features
Connectivity Tool of each blob. In addition, this tool can return
data that defines the perimeter of any
located blob.

Detects edge points with sub-pixel accuracy
along a linear path in a vision image and
returns their positions. Alternately, this tool
can return an array of the intensities along
the linear path or a histogram of their
values.

Edge Locator Tool

28



Overview and Quick Start

Find Centerline Tool

Searches a specified region for edge points
and returns the centerline between two
located bounding lines.

Find Point Tool

Locates the edge point that is closest to the
line that defines the start of the tool's search
region. The XY position of the point is
returned with sub-pixel accuracy along (and
pixel accuracy perpendicular to) the search
direction.

Finder Tool

Most powerful vision tool that identifies
randomly placed parts in a camera image
and returns their position, orientation and
scaling to within sub-pixel accuracy.

Fixed Frame Tool

Places a reference frame at a fixed image
coordinate or at a constant offset relative to
another vision object. Can optionally index
the frame in an X and/or Y grid pattern to
repeatedly execute any linked tools.

Image Process Tool

Performs image filtering, edge extraction,
thresholding and morphological operations
on a specified area in the camera image.

N/A

Inspect Frame Tool

Passes through the XPos, YPos and Angle
Results of a referenced tool and optionally
rotates and shifts the Results based upon
an inspection. The inspection can consist of
the arithmetic combination of the Results of
two other tools. So, this tool also provides a
means for performing simple mathematical
operations on the results of two tools.

N/A

Inspect List Tool

Passes through the XPos, YPos and Angle
Results of a referenced tool and tests up to
12 different Results from multiple tools to
determine if the object is good or bad. This
tool provides a convenient way to perform
complex testing of a located object and
generating an equivalent location with a
single Pass/Fail indicator.

N/A

Inspect Region Tool

Inspects the perimeter and the interior of an

opaque object to determine if there are any
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flaws in the object's outline or holes in the
interior. This tool was designed to inspect
wafers, where slight changes in the overall
size and shape of the wafer are permitted,
but chips in the perimeter or interior holes or
cracks are unacceptable.

Light Recorder Tool

Acquires a sequence of camera images for
a specified period of time, determines the
brightness of each image, and returns the
brightness readings in an array for
subsequent analysis.

Line Fitter Tool

Searches a specified region for edge points
and returns the line that best fits the edges.

Line-Line Frame Tool

Determines the intersection of two lines
defined by vision objects and returns a
reference frame. Alternately, computes and
returns the midpoint of two reference frames
defined by two vision objects.

Pixel Window Tool

Counts edges or binary pixels or collects
gray-scale statistics within a rotated
rectangular or circular region. Used for
quickly detecting the presence of features or
collecting general intensity information about
a region.

Pixel Color Window

= Tool

Tests if the general color of a rectangular or
circular region matches a trained color
within a specified tolerance. Also computes
the mean HSV/HSI values for the region.

Point-Line Frame
Tool

Takes a point and a line from two vision
tools and returns a reference frame.
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Computes a line given two points from two

Point-Point Line Tool Vision tools.

Detects motion in a window region. Ensures
the scene is stable prior to other operations
or waits until motion is detected. Can be
used in place of physical sensors in flexible
parts feeding where parts can take time to
settle.

Sensor Window Tool

Displays string constants plus inspection
and results data from a referenced tool.

N/A . . "
/ Text Label Tool Text is shown relative to the position of the
referenced tool.
Takes the output from another tool that
N/A Tool Filter Tool generates multiple sets of results, and

returns a subset of the results based upon
specified criteria.

Graphical User Interface Overview
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This section summarizes the purpose and use of each of the major components of the PreciseVision
graphical user interface (GUI). The user interface has been designed to allow you to quickly construct a

Vision Process and to easily define the properties for each of the utilized vision tools.

For detailed information on each of the components of the GUI, please read the "PreciseVision User
Interface" chapter. The following table contains a brief summary.
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GUI Component

Description

1. Main Menu and
Toolbar

Provides access to the major functions available within
PreciseVision, e.g. loading and saving projects, selecting the
camera output to view, etc. The toolbar includes buttons for putting
the camera into "live video" mode, taking a single snap shot, and
zooming the camera image up.

2. Vision Camera
Display

Displays the output of the last selected camera. This can be either
a frozen snapshot or a live camera image. When a Vision Process
is being evaluated, the tool Results graphics will be overlaid on top
of the camera image. When a tool is being edited, its outline will be
displayed on top of the camera image. To reposition or resize a
tool, simply drag its handles in this window.

3. Process Manager

Displays and permits editing of all of the Vision Processes defined
within the currently loaded Vision Project. Each process can be
expanded to show the sequence of Vision Tools that are executed
within the process. Tools can be deleted or re-ordered within the
process. To add a new tool, simply drag a defined tool from the
Vision Tool Definition window and drop it on a process name. To
preview how a Vision Process will perform, click on the "Test
Process" green button in the toolbar. This will execute a process
once or continuously without requiring a GPL procedure to trigger
this activity.

4. Vision Toolbox

Lists all of the possible types of Vision Tools that can be created.
To create a new copy of a tool, double click on the tool or right-click
and select "Create tool". Each tool must be assigned a unique
name. New copies of tools are automatically added to the lists in
the Vision Tool Definition window.

5. Vision Tool
Definition Window

Displays all of the tool that have been created. A created tool will
not be utilized in a process until you drag the tool and drop it into
the Process Manager window. If a tool is relative to another tool or
requires other tools as inputs, they will be listed below the tool.
This provides a quick visual queue as to the relationships between
tools.

6. Vision Results
Window

Whenever a Vision Process is executed, the output of each tool
(i.e. its Vision Results) will be displayed in this window.

7. Property Display

Whenever a copy of a vision tool is selected in the Vision Tool
Definition window, all of the properties of the tool will be displayed
in this window. Dimmed properties are read only.

8. Status Bar

Displays status information such as the last Process execution
time, live video/snapshot indicator, networking indicator, camera

calibration type, etc.




Overview and Quick Start

Tutorial 1. Testing Processes and Editing Vision Tools

The first step in learning how to apply PreciseVision is to gain more of an understanding of how vision
tools operate and how to edit tools. Fortunately, PreciseVision provides a very convenient means for
experimenting with the tools without needing a camera, robot or any parts.

In the following procedure, you will be using a Sample Vision Project and camera images from disk files
that are distributed with PreciseVision. One thing to note is that this Sample Project and image files were
generated using standard PreciseVision facilities. So, once you are familiar with the system, you will be
able to create your own Sample Projects and stored images to illustrate your work to co-workers or
customers or to relay problems to Precise and our partners.

Prior to executing this tutorial, the following steps must first be performed:

e The procedure for "Installing PreciseVision on a PC" must be completed.
e No camera hardware of any sort is required.

In this first example, two Edge Locators are executed to compute a line along the side of a part.

» Start by launching PreciseVision. Click on "Start > Programs > Precise Automation > PV
XXX > PreciseVision".

If this is the first time PreciseVision is executed, a pop-up window will be displayed requesting the
specification of the camera hardware followed by a window requesting that the software be activated.
Both of these actions are good to perform and you should return to the installation chapter and follow the
instructions for completing these procedures. However, if you wish, you can cancel out of these pop-up's
since neither of these setup steps is required to initially execute the Sample Projects.

The following "Quick Start" pop-up window should now be displayed.

== Welcome o PreciseVision |
§. PRECISE Welcome to PreciseVision
AUTOMATION Quick Start

— -
-t

Welcome to PreciseVision™

Mew Prapect

PracisaVision™ proides a powerful guidance and inspeciion
system thal is used in combinalion with the Precise Guidance

3 Controler
This package provdes fast, highly accurate, and easy-to-use

Fanbing maching vision tools. B consigls of a graphical user interface that

prowides easy management of building simgle of complax vision
proCessEs

Pracigavigean™ finder and miElralogy teols include sl normalized
cormelation, connectpaly, line fitling, arc Siting, and edge locators
Ramples These funclions are used with golden template and pixel counting Ll

&) Dverviews Cancel

If you hover the cursor over the three buttons on the left, the text in the center window panel will change
to provide more information about each selection.
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» Click on the "Samples" button. A standard file selection pop-up window will be displayed
that lists a number of Sample PreciseVision Project files (*.pvp).

» Click on the "ComputeLineExample.pvp" file and press "Open" to load this Project.
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The default PreciseVision application layout should now be visible and the Camera Display should show
the picture of a "T" part with two green Edge Locators as shown above.

If you examine the Process Manager, you will see that this Project has one Vision Process defined,
"ComputeLine". This Process consists of an Acquisition Tool, "picture”, and a Point-Point Line Tool,
"cl_compute_line". The Acquisition Tool would normally be set to capture an image from a camera. In
this case, it is configured to read the image from a disk file. cl_compute_line does the work of computing
a line from the output of two Edge Locators. The two Edge Locators are implicitly executed and not listed
in the Vision Process (more about this later).

» To test the Vision Process, click on "ComputeLIne" in the Process Manager and then click
on the circular green "Test Selected Process" button in the window's toolbar.

Each time that you click on the "Test Selected Process" button, the Acquisition Tool loads an image file
from the disk and then the Point-Point Line Tool executes the two Edge Locators and fits a line between
their first detected edges. The first time you click the test button, the Camera Display should resemble
the following. You will note that the output line of the Point-Point Line Tool is indicated in yellow.
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For this Sample Project, there are multiple image files and so the captured image and the results will
change each time you click the test button.

» To continuously execute the Sample Project, pull down on the arrow next to the test button
in the toolbar and select "Test Loop".

» To stop the execution, click the "Stop Test Loop" button in the toolbar.

» Next, to examine the defined tools, in the Vision Tool Definition Window, click on each of the
"+" boxes to expand all of the displayed items.

|Wision Tool Definition ? x|
B X|m| - @
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& o edge_locater?
21121 Point-Point Lines
=/ o compute_fine
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The items in the left-most column of the Vision Tool Definition Window are folders that contain all created
tools of a specific type. If a type of tool has not been created, the corresponding tool folder is hidden.
The top-level items listed in the tool type folders are the names of the created tools. The third and
successive levels are lists of tools that are referenced by the tool above it. In this example, in addition to
the "picture" and the "cl_compute_line" tools, two Edge Locators, "el_edge_locatorl" and
"el_edge_locator2" have been created. Note that the names of the Edge Locators appear twice, once in
the top-level Edge Locator tool type list and a second time under the "cl_compute_line" tool. This second
listing indicates that the output (i.e. "Results") of these two Edge Locators are referenced by and used in
the computation of "cl_compute_line".

Since the system knows that the Edge Locators are needed for the computation of the Point-Point Line
Tool (more about how to specify this later), the Edge Locators are automatically executed by the Point-
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Point Line Tool if necessary and they need not be included in the Vision Process. Including the Edge
Locators in the Vision Process before the computation of the Point-Point Line Tool is a matter of personal
preference and does not effect execution time.

The Vision Tool Definition Window provides a convenient means to access all created tools whether or
not the tools are included in any Vision Process. This window also provides a simple graphical
representation of how tools are dependent on and connected to other tools.

» In the Vision Tool Definition Window, click on either of the "el_edge_locatorl" names to
select this tool for editing.

- Gl | ir x|

Once the Edge Locator is selected for editing, it will be displayed in the Camera Display with graphical
handles (as shown above) that allow it to be repositioned and resized.

» To practice repositioning the tool, click anywhere along the green line and drag the tool to
translate it.

» Click on the blue square that indicates the start of the Edge Locator and drag it to stretch or
shrink the tool.

» Click on the blue circle that indicates the end of the tool and drag it to rotate the tool's
orientation.

» To test the Vision Process with a new tool position and size, in the Process Manager, click
on "ComputeLIne" and then click on the circular green "Test Selected Process" button in the
window's toolbar.

When the Edge Locator was selected for editing, you might have noticed that its properties were
automatically displayed in the Property List Display as shown below. In addition to graphically positioning
and sizing this tool, you can also enter new values into this panel. The properties are organized into
groups based upon their function. Readonly values are displayed in dimmed characters.

For each of the tool types, all of the properties are described in detail in the Vision Toolkit Chapter of this
document.
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» In the Property List Display, try editing the "Angle", "Length", and "XPos" and "YPos"
properties and note the effect in the Camera Display.

» If you wish to save your changes to the Sample Project, select "File > Save Vision Project
As..." and assign a new name to your project so the original Sample is preserved.

This completes the tutorial on testing a Sample Project and editing a tool.

Tutorial 2: Adding Vision Tools

In this tutorial, we again make use of the ComputeLineExample Sample Project. In this case, we
present the procedure for adding a Vision Tool to an existing Vision Process. For demonstration
purposes, we will add an Edge Locator that measures the width of the stem of the "T" and validates if this
dimension falls within an acceptable range. In an application that required high precision, you would
probably use two Line Fitters for locating the edges of the "T" stem, but for training purposes, an Edge
Locator will suffice.

Prior to executing this tutorial, the following steps must first be performed:

e The procedure for "Installing PreciseVision on a PC" must be completed.
e No camera hardware of any sort is required.

» If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx
> PreciseVision".

» If PreciseVision is already running, select "File > Quick Start".
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If a pop-up window is displayed requesting the specification of the camera hardware or a window is
displayed requesting that the software be activated, you can cancel out of these pop-up's since neither of
these setup steps is required to initially execute the Sample Projects.

» In the Quick Start window, click on the "Samples" button. A standard file selection pop-up
window will be displayed that lists a number of Sample PreciseVision Project files (*.pvp).

» Click on the "ComputeLineExample.pvp" file and press"Open" to load this Project.
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The default PreciseVision application layout should now be visible and the Camera Display should show
the picture of a "T" part with two green Edge Locators as shown above.

For robustness, the visual inspection should be designed such that the measured width of the stem is
accurate independent of the orientation of the "T". To achieve this, the new Edge Locator should be
oriented perpendicular to the computed Point-Point Line. If the Edge Locator was just placed at a fixed
position and orientation, the width measurement would return too large a value if the "T" is rotated. To
create the new tool, the following should be executed.

» Double click on the "Edge Locator" in the Vision Toolbox.

» In the Name pop-up, enter "el_measure_width" as the name of this new tool and press
"Ok". The new tool will be created and will appear in the Vision Tool Definition Window.

» Click on the new tool in the Vision Tool Definition Window and drag it to the Process
Manager and drop it on "ComputeLine". This will evaluate the new tool after the Results of
cl_compute_line are computed.

» In the Property List Display, pull down the entries for " RelativeToolIName" and select
"cl_compute_line". This makes the position and orientation of the new tool relative to the
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computed position and orientation of the Point-Point Line Tool.

» In the Camera Display Window, resize and position the new tool so that it is approximately
perpendicular to the yellow line for cl_compute_line and stretched across the stem of the "T".

The Camera Display should resemble the following picture that shows the el_measure_width tool drawn
across the stem of the "T" and approximately perpendicular to the yellow line for cl_compute_line.

- G | ik

» To ensure that el_measure_width is exactly perpendicular to cl_compute_line, in the
Property display, edit "RelAngle" to be an even multiple of 90. For example, if it has a value of
-628.2, change this to -630.

» To automatically test the width of the stem, change "InspectType" to
"Distance_From_First_To_Last". This defines the inspected results as the computed
distance between the first and last edge found by el _measure_width.

» To define the width dimensions that we will accept as valid, set the "InspectMax" value to
"31.8" and the "InspectMin" value to "31.2".

» To display a pass or fail label on the tool in the Camera Display, change "InspectLabel" to
"Pass_and_Fail".

» To test the new tool, in the Process Manager, click on "ComputelLine" to select it and then
click on the circular green "Test Selected Process" button in the window's toolbar.

Each time you click the test button, you should now see the new tool in addition to the three former tools.
The new tool should be drawn perpendicular to the yellow computed line and should be labeled to
indicate if the width dimension is acceptable. The following illustrates a typical image in the Camera
Display.
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As you execute the modified Process, you should review the data displayed in the Results Window to see
the numerical value of the computed width. All of the Results information is also available by selecting
individual tools and viewing the data in the Properties List Display.

» If you wish to save your changes to the Sample Project, select "File > Save Vision Project
As..." and assign a new name to your project so the original Sample is preserved.

This completes the tutorial on adding a tool to an existing Vision Process.

Tutorial 3: Applying A Finder Tool

The Finder is the most general purpose tool available for identifying parts or sections of parts and locating
their position, orientation and scale. For constrained or special situations, other tools can be combined to
perform some of these functions. As an example, in the first tutorial, three tools were combined to locate
a known part. But, in that case, the part was only expected to translate and rotate within a limited range.
The Finder Tool utilizes an advanced patented algorithm to both identify and locate parts that are
randomly positioned based upon a simple one-shot training technique.

In this tutorial, we step through the procedure for creating and teaching a Finder using a Sample Project.
This tutorial also includes an example of creating a new Vision Process within an existing Vision Project.

Prior to executing this tutorial, the following steps must first be performed:

e The procedure for "Installing PreciseVision on a PC" must be completed.
e No camera hardware of any sort is required.

» If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx
> PreciseVision".

» If PreciseVision is already running, select "File > Quick Start".
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If a pop-up window is displayed requesting the specification of the camera hardware or a window is
displayed requesting that the software be activated, you can cancel out of these pop-up's since neither of
these setup steps is required to initially execute the Sample Projects.

» In the Quick Start window, click on the "Samples" button. A standard file selection pop-up
window will be displayed that lists a number of Sample PreciseVision Project files (*.pvp).

» Click on the "LocateRandomlyQOrientedPart.pvp" file and press "Open" to load this
Project.

The default PreciseVision application layout should now be visible and the Camera Display should show
the picture of a circular plastic part with a "V" shaped attachment as shown below.
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This Sample Project already includes a Finder as its principal tool. In this tutorial, we will go through the
steps of re-creating this Vision Process including the Finder. Before beginning, the supplied Process
should be tested to see how the Finder performs on this part.

» To see the Finder in operation, click on "Main" in the Process Manager and then click on
the circular green "Test Selected Process" button in the window's toolbar.

» To continuously execute the Sample Project, pull down on the arrow next to the test button
in the toolbar and select "Test Loop".

» To stop the execution, click the "Stop Test Loop" button in the toolbar.

We will now begin creating a new Vision Process. In order to perform the image capture, we will reuse
the existing Acquisition Tool since it has already been initialized to read the desired image disk files.
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» Click on the "Add a new Process" button in the Process Manager toolbar.

» In the Process Name pop-up window, fill in "my_process" as the name and press "Ok" to
create the Process.

» In the Vision Tool Definition Window, in the Acquisition folder, click on the "picture" tool and
drag and drop it on top of the "my_process" in the Process Manager.

Before performing the next step of creating and training a new Finder, the following is background
information and hints that will aid in applying this tool.

When you create a new Finder or re-teach ("re-train") an existing Finder, red and yellow rectangles will be
drawn in the Camera Display as shown below.

= Carea | k=

The red rectangle defines the "Finder Template" for the part to be located. When PreciseVision
subsequently searches for the part, it is looking for matches for the Template in the image. When the
system reports the position and orientation of a matched part, it is actually stating the position of the
center of the Template when the match was found and the amount by which the Template was rotated.
When defining the Template, keep in mind the following guidelines.

e The Template should fully enclose the target object and should contain no other
objects or parts of objects.

e The Template should include some of the background on all sides of the target
object, typically at least 16 camera pixels (too many is better than too few). This
allows the system to distinguish the boundary of the object from the background,
which is especially important for parts with few internal features. For a 640x480
camera, 16 pixels is 1/30th of the full height of the camera image.

e |f the background varies considerably (i.e. it is dirty or has blotches), the part
should be trained on a uniform neutral background.

e The target object should be oriented in the camera image in what you want to
define as ‘Zero’ degrees. That is, when the Finder later locates a part is in the
trained orientation, it will return an orientation angle of 0 degrees.

The yellow outline defines the "Training rectangle”. This rectangle is used to teach the system how to
distinguish the Template from other objects or background clutter. When defining this rectangle, keep in
mind the following guidelines.
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e This rectangle must be larger than the Template and must fully enclose the
Template.

e This rectangle should include one and only one complete copy of the target
object. It's okay if this region includes other partial copies of the target object so
long as each partial copy is less than 50% of the target object.

e This rectangle should include any other objects or clutter that are expected to be
encountered during runtime to aid the system in learning to distinguish between
the target object and its surroundings.

e This rectangle should be as large as possible without violating the rules above.
A larger region permits the system to test more positions and orientations for the
Template during the training phase and assists in optimizing the runtime search
strategy.

It's now time to create the Finder and add it to the Vision Process.

» Double click on the "Finder" in the Vision Toolbox.

» In the Name pop-up, enter "my_finder" as the name of this new tool and press "Ok". The
new tool will be created and will appear in the Vision Tool Definition Window.

» Follow the step-by-step instructions within the "Finder training" Application Wizard that is
displayed to setup the Finder keeping in mind the hints above.

» Click on "my_finder" in the Vision Tool Definition Window and drag it to the Process
Manager and drop it on "my_process". This will evaluate the Finder after the camera
acquisition is executed.

» To test the new tool, in the Process Manager, click on "my_process" to select it and then
click on the circular green "Test Selected Process" button in the window's toolbar.

Congratulations, you just created your first Vision Process that identifies and locates randomly parts! You
can continue to click on the test button or execute your process in a continuous loop.

» If you wish to retrain the Template at anytime, click on "my_finder" in the Vision Tool
Definition Window to select it. Then click on the arrow to the right of "Finder Operation Mode"
icon on the window toolbar and select " Train Mode". You can also restart the Finder Training
Wizard in this same pull-down if you wish.

» If you wish to save your changes to the Sample Project, select "File > Save Vision Project
As..." and assign a new file name to your project so the original Sample is preserved.

» At this time, we highly recommend that you execute each of the distributed Sample Vision
Projects, review their Vision Processes and edit the Tool Properties to get an understanding of
more of the vision tools.

This completes the tutorial on creating a Vision Process and applying the Finder Tool.
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Tutorial 4. Developing a Robot Vision Application

This tutorial illustrates how to develop a simple, but complete, robot vision guidance application. It
presents both the PreciseVision Project and the GPL software that must be executed on a Guidance
Controller. This tutorial requires that your robot and Guidance controller be operational and interfaced to
the PC executing PreciseVision.

Prior to executing this tutorial, the following steps must first be performed:

e The procedure for "Installing PreciseVision on a PC" must be completed.

e A camera must be rigidly mounted over a region that can be reached by the
robot.

e The camera interface must be installed and interfaced to PreciseVision using one
of the procedures in the "Hardware Installation" section of this manual.

e The robot must be fully operational and interfaced to the PC via Ethernet.

e The procedures outlined in "Configuring Communication Between the PC and the
Controller" that permit the two systems to exchange data must have been
performed.

e The "Robot Vision Area Camera Calibration" must have been executed to define
the camera's pixel-to-millimeter conversion and the transformation from the
camera's frame of reference to the robot's frame of reference.

e The Guidance Development Suite must be installed on the PC and you should
have a modest ability to develop and execute GPL programs.

» If PreciseVision is not running, click on "Start > Programs > Precise Automation > PV xxx
> PreciseVision".

» If PreciseVision is already running, select "File > Quick Start".

» In the Quick Start window, click on the "New Project" button.

You should now see the "Create New Project From Application Template" pop-up window that resembles
the following.
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The "Create New Project From Application Template" is a wizard that builds a complete Vision Project for
a number of common tasks. For example, the "FinderLocatingPartWithClearGrip" constructs a Project
that uses a Finder Tool to locate an object and then executes two ClearGrip Tools to verify that the parts
can be grasped without hitting an obstruction. In particular, this wizard deletes the current Vision Project
(after confirmation if the Project should be saved), creates a new Project, and automatically creates the
Vision Tools and Vision Processes for the selected task. The wizard then walks you through the steps to
position, size and train each of the tools for your parts. Over time, we will be adding additional templates
to address even more common tasks and we will be adding the ability for you to add your own templates
to simplify the use of the system by your co-workers or customers. Of course, you can always create
your own Vision Projects, Processes and Tools using the basic methods described in the other tutorials.
The Application Wizard is just a convenience for people learning about the system or it can serve as a
starting point for those already familiar with the system.

For this exercise, we will be selecting the "FinderLocatingSinglePart" template. This takes a single picture
and then employs a single Finder Tool to locate your part.

» Click on the "FinderLocatingSinglePart.pvt" file, click on "Create" and then follow all of
the instructions of the wizard to create your Vision Project. At the conclusion of the wizard, the
Project, Process and Tools should all be created and the Finder should be trained on your
object.

» Save your Project by selecting "File > Save Vision Project As..." and assigning a file for
your Project.

» To test your Project, place your object in the camera’s field-of-view, click on "Main" in the
Process Manager and then click on the circular green "Test Selected Process" button in the
window's toolbar.

» To validate that the Vision Project and the camera calibration are working properly, using
the same robot pointer you used during the camera calibration process, manually move the
robot to the X/Y position indicated in the Results Window "RobX" and "RobY" values and
verify that the tool is at the center of your part's Finder Template.

PreciseVision is now setup and ready to receive commands. It is not necessary to place PreciseVision in
a special mode to work with the robot, it is always listening for commands from a GPL system. So, there
is no further development to be done in PreciseVision.

The next step is to develop a GPL project that will execute the Vision Process "Main", retrieve the "part1"
Finder Results and move the robot to the specified position. A simplified version of the required program
is presented in the "Guidance Programming Language, Introduction to GPL" manual in the Vision section
and is repeated below.

» Within GDE, the Guidance Development Environment, in the Project Manager, create a new
GPL Project named "Robot_vision".

» In the new "Robot_vision" Project, double click on the "Main.gpl" file to begin editing.
» In the editor window, below the "Public Sub Main" statement, insert the following lines of

text. If you are reading this exercise in the Precise Documentation Library (the online help file),
this can be accomplished by copying and pasting if you wish to save yourself some typing.

Dim vis As New Vision
Dim vResult As New VisResult
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Robot.Attached = 1
Move.Loc(safe, vsProfile)

vis.Process(*'Main') ® Run vision process "Main"

IT vis.ResultCount("'partl'™) = 0 Then
Console.Writeline("Vision object not found™)
Goto done

End If

VResult = vis.Result(“partl™, 1) " Get results

" Create a reference frame object and set it
" equal to the returned vision location

Dim vsRefFrame As New RefFrame
vsRefFrame.Loc.PosWrtRef = vResult.Loc

® Pickup point is relative to new frame
vsRelPoint.RefFrame = vsRefFrame

Move . Approach(vsRelPoint, vsProfile)
Move.Loc(vsRelPoint, vsProfile)
Move . Approach(vsRelPoint, vsProfile)

" Move back to safe location
Move.Loc(safe, vsProfile)

done:

» In the the "Robot_vision" Project, double click on the "GModule.gpo" file to access the
global Motion Objects panel.

» Create and teach a Location named "safe" that positions the robot so it is not obstructing
the camera's view of the part. Also, create a Motion Profile named "vsProfile" that will be
used to slowly move the robot to the part.

» Create a Location named "vsRelPoint". This will define the robot's pickup position relative
to the Location returned from PreciseVision. Normally, it would be best to manually define this
Location relative to the actual value returned from the vision system. But for demonstration
purposes, set its properties to the following where the Z value is a safe world coordinate value
above the part.

X=0

Y=0

Z =Z_safe
Yaw =0
Pitch =180
Roll =0

» Press the "Save Document" icon on the main tool bar to save your changes.

» To load your application, in the Project Manager, drag the "Robot_vision" Project from the
PC to the top "Loaded Projects" panel and drop it.

You have now completed the development of the GPL Project and we are ready to execute the complete
vision guided robot application.
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DANGER: Before proceeding with this procedure, please ensure that the
robot has been properly mounted, all required safety interlocks have been
A installed and tested, and power has been connected. For the
PrecisePlace robots, this information is provided in the “PrecisePlace
2300/2400 Robot, Hardware Introduction and Reference Manual”.

» In the GDE Robot Control Window, set the "Robot Speed" to approximately 5%. This will
force your Project to move the robot at 1/20th of its normal speed.

» This next action will move the robot automatically to a position computed by
PreciseVision, so be prepared to hit the E-Stop button or disable power if any problem
occurs!

» With your part placed in the camera's field-of-view, execute the GPL Project. When you run
a GPL program for the first time, it is advisable to start the project in debug mode. This can be

done by selecting "Debug > Start with break" or pressing " Shift-F5". Single step through the
program one line at a time by pressing "F10".

Congratulations, you just created your first full vision guided robot application!

For more information on the GPL vision interface, please read the Vision Guidance chapter of the
"Guidance Programming Language, Introduction to GPL" manual. This contains an overview of the built-
in GPL vision classes, methods and properties. For more detailed information, please see the "Guidance
Programming Language, GPL Dictionary Pages".
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PreciseVision User Interface

The PreciseVision Graphical User Interface (GUI) consists of a title bar that displays the name of the
opened project, a top menu bar, a main toolbar, and a variety of dockable windows. Each of the dockable
windows can be displayed or hidden, resized and repositioned into the arrangement that is most efficient

for your use.

When PreciseVision is started for the first time, the following default arrangement of the various elements
of the GUI is presented.
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To reposition a window, you simply click in its title bar and drag it to its new location. If you drag a
window on to another window, they can split the space or share the space using tab controls. If you click
on the close icon (x) in the top right of a window's title bar, you can use the "View" top-level menu to
redisplay the window. If you click on the "push pin" in the top right of a window's title bar, you will either
"pin" a window and fix its location or "un-pin" a window so it can share its space with another window.

Windows can be resized by grabbing a border and stretching or shrinking it to the desired dimension.
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In the following sections, the functions supported by each of the major elements of the PreciseVision GUI
(i.e. main menu bar, tool bars, and windows) will be described. In addition, the Preferences Panel for
specifying system configuration information is also described. The graphical components are presented
in order of importance rather than alphabetically. To jump to a specific description, click on a label in the
picture above or on a window.

Main Menu and Toolbar

The Main Menu and the Main Toolbar provide access to general functions such as displaying the
dockable windows, saving and loading Vision Projects and launching the camera calibration operations.
This menu and toolbar appear as follows.

File “iew Tool Help
Az ta-Ma-05-58

The following tables describe the operation of each of the selections within the Main Menu and are
organized by the name of the top-level menu. These tables are followed by a description of each of the
Toolbar buttons.

File Description

Displays the pop-up Quick Start window that is shown each time
PreciseVision is started. This window allows an existing Project to
be loaded, sample canned Projects to be loaded, or a new Project to
be constructed by a step-by-step wizard that supports many common
procedures. The latter two options are very instructive for individuals
who wish to learn about machine vision or PreciseVision.

Displays a sub-menu with selections that create either an empty un-
named Vision Project or a new Project constructed by a step-by-step
New Vision Project |wizard that supports many common procedures. An additional sub-
menu selection permits the last executed wizard to be re-executed to
allow editing of the previously generated Vision Process.

Opens a new Vision Project from the disk and loads it into memory
replacing the current Vision Project. The standard file pop-up window
is displayed to allow browsing to the desired folder. PreciseVision
project files have a ".PVP" file extension.

Loads in the Vision Project contained in a file and merges its
contents with the currently loaded project. If the new project contains
Import Vision any processes or tools whose names conflict with items that are
Project already loaded, "_r" is appended to the name of the new item. Also,
any camera calibration information that is contained in the new
project is ignored.

Copies the currently loaded Vision Project into another directory. As
part of the copy operation, the extra files associated with certain
vision tools, such as Finder templates files, and the camera
calibration files can also be automatically copied.

Quick Start

Open Vision Project

Export Vision

Project Normally, PV stores camera calibration files into a central folder to

permit them to be shared by multiple Projects. If you manually copy
a project area, the calibration file will often not be copied or the link to
the file will be broken. The Export utility can automatically copy the
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applicable calibration files with the other Project files and can zero
the link. If the link is zeroed, when the Project is reloaded, the
calibration files stored in the Project folder will be utilized.

The Export function is also useful if you have multiple PV systems,
each with unique camera calibrations, but you wish to execute the
same Vision Project. In this case, you should Export the Project
without calibration files and with zero'ed links. For each PV system,
you start by loading its unique calibration files. You then load the
exported Project to associate the generic Project with the individual
calibration files.

Save Vision Project

Either saves the loaded Vision Project to its associated disk file or

Save Vision Project
As ...

displays a pop-up file window to allow the operator to browse to the
desired disk folder and assign a disk file name.

Close Project

Closes the loaded Vision Project after prompting if any changes
should be saved to the Project's disk file. The close operation
deletes all defined tools and Vision Processes resulting in an empty
un-titled Project.

Preferences

Displays the PreciseVision Preferences panel. This panel contains a
number of application setup parameters that customize the operation
and appearance of PreciseVision, e.g. enable/disable the display of
the Main Toolbar or tool graphics.

Acquire New Image

Takes a single snap shot from the currently selected camera and
loads the image into the Camera Display window.

Reinitialize Camera
Connections

Reinitializes Dalsa cameras that have stopped operating after being
disconnected and reconnected or due to network connectivity
disruptions. PreciseVision normally tries several times to reconnect
to cameras that are no longer operating, but will eventually stop
retrying. This function forces the system to perform additional retries.

Image Load / Save

Diagnostic and debugging aid that loads a camera image from a disk
file into the Camera Display window or saves the currently displayed
image to a disk file.

Lock / Unlock
Application

Locking an application prohibits users from modifying the loaded
project. This is useful for avoiding situations where a user might
inadvertently change a parameter or tool and cause a vision project
to no longer operate correctly. Locking dims out all menu items,
removes most toolbar items, and inhibits closing PreciseVision.
Unlocking requires a password if a password has been defined in the
Preferences panel.

Exit

Terminates execution of PreciseVision

View

Description

Layouts

Provides "Load Default", "Load Layout" and "Save Layout" selections
for permitting custom desktop layouts to be preserved, reloaded or
set back to the normal default. Also provides "Load Runtime
Layout", "Load Edit Layout" and "Load Calibration Layout" for putting
standard layouts into effect. These standard layouts can also be
accessed from the main toolbar.

Select Camera

Selects the camera whose image is to be presented in the Camera
Display window. This also specifies the camera that is utilized in the
Camera Calibration methods and other functions.
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Debug

Brings up a submenu that permits displaying log files that contain the
bi-directional communication messages between PreciseVision and
Guidance Controllers or Remote PC Servers. Generating these log
files can be enable via the Preferences Pop-Up.

Process Manager

Vision Tool
Definition

Permits any dockable window that has been closed to be re-

Vision Toolbox

displayed.

Property Display

Results Display

Guidance Web
Panels

Opens up to three web panels specified in the 'Preferences -> Web
Interface' tab. This provides convenient access to the Precise
Guidance Controller web interface.

Project Version

Sets and displays the version number and text description for the
currently loaded vision project.

Refresh

Redraws any graphics generated by vision tools in the Camera
Display window. This is convenient because the graphics can
sometimes be lost when PreciseVision is minimized or if you click on
certain panels.

Tool

Description

Calibrate Vision

Initiates the execution of the camera calibration wizard. This
procedure determines the pixel-to-millimeter conversion for the
selected camera and also the conversion from the camera's frame of
reference to that of the robot.

Camera Calibration
Configuration

Displays a pop-up window that associates a camera calibration file
with a specific camera in the current Vision Project. The information
in this pop-up is saved and reloaded with the Vision Project.

Show Camera
Information

Displays a pop-up window that shows which camera is selected and
the camera calibration data that is in effect.

Camera Video
Properties

Displays a pop-up window that permits the brightness range and
offset for the currently selected camera to be set. This is helpful
during the setup procedures for the Camera Calibration methods and
other functions.

Show Vision Tool
Cross Reference

Displays a pop-up window that either: (1) lists the vision processes
and vision tools that reference each defined tool or (2) lists the
defined vision tools that are not referenced by any vision process or

Information any vision tool. This function is useful for understanding the
relationship between vision tools in complex applications.
Help Description
Contents
\F;'re'mseTVls:on GUl Opens the Precise Documentation Library in a separate window and
OI\%?Ciev(\)/o S jumps to the specified section that is relevant to PreciseVision.

GPL Programming

Product Activation

Displays the pop-up window used for activating this product.
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Camera Driver Info

Presents the version and identification information for installed
camera drivers.

About PreciseVision

Generates a popup window that displays the PreciseVision version
and ID information along with build information for key components of
this application package.

Ilcon

Tool Tip Title

Description

Create new Vision
Project

A new empty un-named Vision Project is created by
deleting all of the tools and existing Vision Processes.
If the current Project has been changed and needs to
be saved to the disk, a pop-up is first presented that
permits the operator to save the modifications.

Save current Vision
Project to disk

Saves the loaded Vision Project back into its disk file. If
the current project has never been saved to the disk, a
file pop-up window is displayed to allow the operator to
browse to the desired disk folder and assign a disk file
name.

T

Open a Vision Project

Opens a new Vision Project from the disk and loads it
into memory, replacing the currently loaded Project.
The standard file pop-up window is displayed to allow
browsing to the desired folder. PreciseVision project
files have a ".PVP" file extension.

Display live video
camera image

Places the currently selected camera into "Live Video"
mode. Pictures will be taken continuously and
displayed in the Camera Display window. This mode is
very convenient for setting up the focus, f-stop, gain,
and offset of a camera. If the camera is already in live
video mode, pressing this button will terminate this
mode.

Take a single snap shot

Takes a single snap shot (i.e. picture) using the
currently selected camera and displays the results in
the Camera Display window.

Toggle Color Display
Mode

For color cameras only, toggles the Camera Display
window display between color and grayscale mode.
Set to color display mode by default.

Zoom the Camera
Display window

Zooms the Camera Display window view in or out.
Pressing the button zooms in. A pulldown menu tied to
this button zooms out or resets the window to its un-
zoomed state. If "Zoom Auto" is selected, the active
vision window is automatically scaled so as to best fit
within the display window. The zoom factors range
from 0.1 to 5 in steps of 0.1.

Refresh Camera Display
window graphics

Redraws any graphics generated by vision tools in the
Camera Display window. This is convenient because
the graphics can sometimes be lost when PreciseVision
is minimized or if you click on certain panels.

Switch display layout

Switches between three predefined display layouts:
Edit, Run and Calibration. This icon makes changing
the display layout very easy.

Lock / Unlock
Application

Locking an application prohibits users from modifying
the loaded project. This is useful for avoiding situations
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where a user might inadvertently change a parameter
or tool and cause a vision project to no longer operate
correctly. Locking dims out all menu items, removes
most toolbar items, and inhibits closing PreciseVision.
Unlocking requires a password if a password has been
defined in the Preferences panel.

Vision Camera Display

The Camera Display window shows the captured image from a selected camera with graphics to illustrate
applicable vision tools. The camera image can be a "live video" display, which means that the captured
image is continuously updated, or a single snap shot. The vision tool graphics illustrate the placement of
tools and their computed results. When a tool is selected for editing, the graphics also include handles
that permit the tool to be easily re-positioned, re-oriented and re-sized using a mouse.

The following picture is a typical camera image with overlaid tool graphics. For all cameras, the X-axis of
the camera coordinate system points from left to right and the Y-axis points from the bottom of the display
to the top. The origin (0,0) of the camera coordinate system is in the lower-left corner of the camera
image. If the camera is not calibrated, X/Y positions in the camera image are returned in units of raw
pixels relative to the lower-left corner of the camera image. If the camera is calibration, X/Y positions are
typically in units of millimeters relative to the origin.

= Cameral 4bF x

To accommodate large or small images (those with many or few pixels), the camera display can be
zoomed out or zoomed in. The control for this operation is provided on the Main Toolbar along with icons
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for manually placing a camera into live video mode and taking a snapshot. The Main Menu contains
other commands for changing the selected camera and adjusting their gain and offset.

The following images describe how to utilize the graphical handles to place and size a typical vision tool
and options for controlling how the results of a tool are illustrated in the Camera Display Window.

Graphical Display Description

This is a snap shot of a Line Fitter Tool placed over one
edge of a part. The green and blue perimeter lines indicate
the tool's search area. The blue edge marks the side of
the search region that should be positioned on the dark
side of the edge. The red line illustrates the results of the
tool and marks the best fit line.

To position the tool, click anywhere in the search region
and drag the rectangle. To resize the tool, click one of the
four blue squares and drag. To rotate the search region,
click the blue circle and drag.

If the output of a tool is to be utilized as an input (X, Y)
point for another tool, it is informative to display the result
as a single position. In this picture, the ShowResults
property for the Line Fitter has been set to "POINT". This
places a yellow "X" at the origin of the output of the Line
Fitter. Note, setting ShowResults only affects the
graphical display and does not alter the results computed
by the tool.

In this example, if the output of the Line Fitter is to be
interpreted as a line, the ShowResults property for the
Line Fitter can be set to "LINE".

In this final example, the output of the Line Fitter is to be
interpreted as a reference frame, so the ShowResults
property for the Line Fitter has been set to "FRAME".

54



Graphical User Interface

Process Manager Window

The Process Manager Window displays the list of all of the Vision Processes that are contained in the
currently loaded Vision Project. If a Vision Process is expanded, all of the Vision Tools for the Process
are displayed in the order in which they are evaluated. This window is the primary means for managing
Vision Processes including their creation, renaming, deletion, modification and test execution. Any
Process that is displayed in this window is eligible for execution by a GPL procedure running on a Precise
Guidance Controller.

A typical Process Manager Window is shown below.

Process Manager

Hlp-Olx1t i

ET‘. LocateMultipleP arts
o B picture_1 [Acquisition)]

f@} part [Finder)
+i el_test_part [Edoe Locatar]

In this example, a single Vision Process "LocateMultipleParts" is contained in the currently loaded Vision
Project. This Vision Process has three tools. The Process begins with the standard Acquisition Tool that
takes a picture. After the picture is captured, the system evaluates a Finder Tool named "part". The final
operation is an Edge Locator "el_test_part".

It should be noted that if the Edge Locator is defined relative to the Results of the Finder Tool, the
Process could have been written without the explicit execution of the Finder. When the system
encounters the Edge Locator, it would automatically execute the Finder if the Finder had not been
evaluated. The decision of whether to include the Finder in the Vision Process is entirely a matter of
personal preference. Whether or not the Finder is included, the Results of the Process would be identical
as well as the execution time.

To add a new Vision Process to a Project, click the toolbar icon to "Add a new process”. Once the new
Process is assigned a unique name, it will appear as a top-level (i.e. left-most) item in the window. To
specify the sequence of tools to be executed in the process, simply drag Vision Tools from the Vision
Tool Definition Window and drop them on the Process. New tools are automatically added to the end of
the Process and can be re-ordered by using the up and down arrows in the toolbar. The order of
appearance of the tools is important since the tools are evaluated top to bottom in the displayed list.

After a Vision Process has been created, it can be renamed by right-clicking on its name within the
Process Manager window and selecting "Rename Process."

Once a Vision Process has been created, it can be triggered from GPL or can be manually tested using
an icon on the toolbar. The manual test can be executed a single time or the process can be executed
continuously. The continuous test mode is intended for demonstration purposes since the execution of
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the Process will not be synchronized with the GPL robot program and therefore not of very much practical
use.

The following tables provide additional information on each of the window toolbar options.

Icon Tool Tip Title Description

Creates a new Vision Process and adds it to the

. Process Manager Window after it has been assigned a
# Add new process unique name via a pop-up window. The Process
names are very important since they are used by GPL
procedures to initiate the execution of a Process.

Test executes the selected Process once or
continuously. This is useful for debugging a Process
and examining its computed results. However, in a

k) [Test selected process  [robot guidance application, Processes are always
initiated from a GPL procedure to ensure that the
picture taking and evaluation are coordinated with the
robot motions.

If a process is running in a continuous test mode, this
) [Stop testloop button will stop the Process. This is only used while
manually test executing a Process.

Removes a Process from a Project or a tool from a
Process. In both cases, any referenced tools are not
7% |Remove selected item |deleted from the Project, only the reference to the tool
is removed. To delete a tool, you must use the Vision
Tool Definition Window.

1+  Move tool up Moves a vision tool up or down one line in a Vision
Process list. The order in which the tools are listed in a
Process is important because this is the order in which
the tools are evaluated. If a Vision Process is selected,
these button will change the order of the Processes
within this window. This is a convenience feature and
does not alter how Vision Processes are executed.

4+ |Move tool down

Vision Toolbox Window

The Vision Toolbox Window displays a list of all of the vision tool types that can be employed to construct
a Vision Process. The top of this list currently looks as shown below.

Wision Toolbos 7 ox|

2 Acquisition
& A Fitter

B Clear Grip
B Connectivity
{- Edge Locatar
3 Fird Mid Line

[H Find Paint
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To add a new tool to an application, double click on a tool type in this list or right-click and select " Create
Tool". A pop-up will be displayed for assigning a unique name to the new copy of the tool. Once a name
has been assigned, the new tool will appear in the Vision Tool Definition Window. Once there, the tool
can be edited or dragged into the Process Manager to add the execution of the tool to a specific Vision
Process.

Vision Tool Definition Window

The Vision Tool Definition Window displays all of the tools that have been created in the currently loaded
Vision Project, even those that are not referenced in any Vision Process. This window provides the
primary means for adding tools to a Vision Process and for selecting tools to be edited. As a
convenience, this window graphically indicates when tools are dependent upon the results of other tools.

A typical Vision Tool Definition Window will appear as shown below.

Yision Tool Definition

| }(| LJ| /‘@J = &) Train

= ps Acquisition
o pichure 1
=== Edge Locators
- oF edge_?

=g el_test_part
o} part
=g Finders

To simplify accessing tools, all of the defined tools are grouped according to their tool type and only tool
types that have one or more tools defined are visible. In the example above, there is one Acquisition Tool
named "picture_1", two Edge Locators named "edge_2" and "el_test_part" and one Finder Tool named
"part". The second Edge Locator has been defined with respect to the results of the Finder, so the Finder
"part" appears below "el_test part" to indicate this relationship.

There are a number of ways that a new tool can be added to the Vision Project and the Vision Tool
Definition Window:

e Double click on a tool type in the Vision Toolbox Window.

¢ Right-click a tool or tool type in the Vision Tool Definition Window and select
"New Vision Tool".

e Drag a tool type from the Vision Tool Definition Window and drop it into the
Camera Display Window.

e Right-click in the Camera Display Window and select "New Vision Tool".

To copy an existing tool while maintaining its dependencies to other tools, highlight the tool in this window
and click the "Copy" icon in the toolbar or drag the existing tool and drop it into the Camera Display
Window.
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To edit a tool, simply click on the name of the tool. This will automatically display the properties of the
tool in the Property Display Window and will highlight the editing graphics and the handles for the tool
within the Camera Display Window.

To test the operation of a tool without executing a Vision Process, click on the tool and click the "Play"
button in the toolbar. This only executes the selected tool and any tools on which it is dependent. If the
tool on which it is dependent returns multiple results, e.g. a Finder, only the first set of results is
processed by the tool being executed. This is done to permit you to easily reposition the executed tool.

The following tables provide additional information on each of the window toolbar options.

Icon Tool Tip Title Description
Create co Copies the selected tool along with its relationships to
by other tools.
X [Remove selected tool Deletes the selected tool after confirmation but does

not effect any tools that it references.

Executes the selected tool and all of the tools on which
P} |[Execute selected tool |it is dependent without executing a Vision Process.
See above for further information.

For Finder Tools, switches between "Find" and "Train"
mode. Can also launch the Training Wizard to assist in
teaching a Finder Tool and can display a trained Finder
template at various resolutions as a diagnostic aid.

For tools that require training, executes the training
process. In the case of the Finder Tool, this records the
Finder Template and performs the analysis to
determine distinctive features and the maximum levels
of the search pyramid.

/B |Finder operation mode

® Perform training
operation

Property List Display

In PreciseVision, each Vision Tool is internally represented as a software "Object". The parameters for
each tool are referred to as its "Properties”. The properties include both the values that specify how a tool
operates (e.g. its tool type, tool name, position, size, operating characteristics, etc.) as well as the values
that indicate the results of executing the tool (e.g. number of objects found, number of edges located,
etc.). For a given type of Vision Tool, the list of properties is always the same, but the list will vary from
one type of tool to the next.

Some Vision Tools provide special buttons that are displayed between the tool name and the property
grid. These buttons provide access to tool specific operations during the editing process (e.g.
automatically snapping a tool into position).

The Property List Display provides a very convenient means for both viewing and editing the property
values of a tool. As an example, the Property List Display for a typical Fixed Frame Tool is shown below.
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Froperty Display
== 8|
B 1.1dentiy
baszeline_1
Type WeFinedFrame
B 2 Placement / Size
Angle 30.69273
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B 3. Operation
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Bl 6. Results
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Mame
Yizgion Tool Mame

The pull-down list at the top of the window selects the tool to be displayed. The displayed tool will also be
automatically changed whenever a new tool is created or a tool is selected in the Vision Tool Definition
Window.

Once a tool has been selected, any of its writable values can be modified by clicking on a cell and
entering a new value. When a property is selected, a short description of the property is displayed at the
bottom of the window. Properties that are readonly are indicated by dimmed text.

To assist in accessing these parameters, the properties are group according to their use. A description of
each of the groups is presented in the following table. For detailed information on the properties for each
of the tool types please see the chapter on the "Vision ToolKit".

Property Group Description

1. Identity Properties Specifies the name of the tool and its basic tool type.
Defines the position, orientation and size of the tool in the
coordinate system of the camera. In addition, if the tool is

2. Placement / Size defined relative to another tool, the relative position and
Properties orientation can also be specified. Normally, it is easiest to
graphically position and size each tool by dragging on the
tool's handles displayed in the Camera Display Window.
Defines parameters that control the execution of the tool. For
example, a tool might have an Operation Property that
defines if it should screen out black-to-white edges or the
gray scale levels above which pixels are processed. Only the

3. Operation Properties
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commonly used Operation Properties are placed in this
group.

3A. Advanced Operation
Properties

Contains Operation Properties that are not normally modified
and generally require a bit more experience to utilize. For
these properties, their default settings will yield good tool
performance for typical applications.

4. Inspection Settings
Properties

Permits a single scalar result of the vision tool to be
automatically tested (inspected) to verify that it is within
limits. A Pass / Fail property is set accordingly and a Pass /
Fail label can be optionally displayed on the tool in the
Camera Display Window.

5. Results Settings
Properties

Controls the results that are computed by the vision tool. For
example, if multiple sets of results can be computed by the
tool, these properties can limit the number of sets of data
computed and can select the set of data that is displayed in
the Results Properties.

6. Results Properties

Displays a single set of results for the vision tool. In general,
the results returned varies from tool to tool. Many tools return
a vision reference frame. However, some tools return
additional results items such as statistical information on how
well the answer fits the actual data.

Vision Results Display

The Vision Results Window displays the "Results” properties for all of the tools evaluated in the previously
executed Vision Process. For position and orientation data, the results are displayed in both the vision
coordinate system and the robot coordinate system utilizing the applicable camera calibration data. The
information contained in this display is automatically updated each time a Vision Process completes

execution.

A typical display that illustrates the results of a Vision Process that contains both a Finder and a Edge
Locator Tool is shown in the following picture. For tools that return multiple sets of results (e.g. the Finder
or Connectivity), if you click on a line in the Results display, the corresponding object will be highlighted

with a blue coordinate frame in the Camera Display.

visonresuts X
EH £ | Process LocatebulipleParts

Mame Jice [ vis® [ VY | Visénge | Rob | RchY | Rohdngs | Passed | InspVal| Special Resus | Enon.
past Finces] 1 1239563 5569994 GR43F2 1239563 GH6004 STMI2 Pam O 0.9910065,1,1.30.8331  OX
part [Finder] Z  GE0S4T  BT.T4523  IT42ET1 BGOS43 | BTTASZE 1742671 Pasr 0 0971400211 30 69531 0K
paet [Fiches) 3 1R SOSMI7  TASITA? 137023 | MAMTT TASETE?  Pass D 096975211 30893 OF
past [Firiched] 4 SSEE09) EIEIMD S2MSS3 SSEE0N) GIEXIC WIS Pa D D9E5EI061 1 306933 O
past [Fincled) § 7RIS 1176979 JGMMDES  7EENS4  117ENY IGMIES Pass O D9E40N52.1.1. 3069331 OF;
part [Fincea] B 109633 104232 ES04865 109633 104232  BADMESS Pass O 0950187 11,0633 0K
el test_pait [Edgelocatad] 1 1235563 GSEEY934 ST MIT2 1219563 SSE90 ST M Pas 9 0%,
el best_part [EdgeLocalod] 2 BEOSAT  B7.74523 1742671 BEOS4% BYT4EZ3 1F4ZET] P 9 ox
el test_partfEdgeLocaton) 3 1397029 S0SM77 7992782 1397023 909M77 7R9ETE2  Pasr 9 o,
el test_pait [Fdge Located 4 956097 BIE23R7 41953 SSGE0S? GIEZ 41553 Pm: 8 ok
el best_pait (Edge Locaiod] 5 THINGY 1176379 IG0M085 FAZNSY NTESTS IE0M0E5 Fas 9 0%,
el_test_part[Edgelocator) B 1096939 104232  G30MBS5 1096339 14232 BIMESS Pass 9 oK
| |

The following tables provide additional information on the window toolbar options and the data provided in

each column of the results table.
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Icon Tool Tip Title Description

EH |save

Stores the results data in a comma delimited file
(*.CSV) that can be read into a spreadsheet application
for further processing. A standard popup file window is
displayed to allow the file name and disk directory path
to be specified.

Copy to clipboard

Copies the contents of the results table to the system
clipboard in a comma delimited (*.CSV) format. This

information can then be pasted into another application.

B Timer

Displays the execution time for each top-level tool in
the previously executed vision process in place of the
tool results. The incremental time for each tool is
displayed as well as the cumulative execution time for
all tools in the process, in milliseconds.

Data Column

Description

Specifies the name of the vision tool that generated the

Name
results.
For tools that return multiple sets of results, this is the index
Idx for the set of results that is displayed on a line. The index
value goes from 1-n.
Vis X For tools that return a position and orientation, this is the X &
Vis Y Y position in millimeters and the angle in degrees. These
. values are in the coordinate system of the camera’s field-of-
Vis Angle iew
Rob X For tools that return a position and orientation, this is the X &
Rob Y Y position in millimeters and the angle in degrees. These
values are in the robot's world coordinate system and are the
Rob Angle values that are transferred to a GPL program in a vision
guidance application.
Pass / Fail results of the tool Inspection. This is the same
Passed
value as the InspectPassed property.
Insp Val Actual property value that was tested by the tool Inspection.

This is the same value as the InspectActual property.

Special Results

Each vision tool may have additional results that are unique
to the tool type. For example, the Connectivity Tool returns
the area of located blobs (ResultBlobArea). The Special
Results column provides a place to display up to 20 tool
specific results per vision tool. These special results are the
same values that can be retrieved by a GPL program using
the VisResults.Info method and are indicated in the
documentation for each tool by [GPL: VisResult.Info(x)].
When a Connectivity Tool is executed, the blob area can be
fetched as VisResult.Info(3) and will be displayed as the 3rd
number in the Special Results column.

Errors and Warnings

Specifies if an error or warning condition occurred when the
tool was executed. This is the same value as the

ResultErrorCode property.
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Application Status Bar

The bottom of the PreciseVision application window contains the Status Bar. This area continuously
displays status information on the execution of the application. The Status Bar typically resembles the
following.

||; |@ Still Image IEamera: 1 File; Example |Eal Type: Camera Only |F'ru:u:ess Tirne: 0.07 |—|><=?4, =73 Gray=34 IMDdified: Mo 4

The information contained in each of the columns of the Status Bar is described in the following table.

Col # Data Description

Indicates Ethernet traffic between PreciseVision and a

1 |Server status Guidance Controller. Each time a message is received,
the icon will flicker.

Indicates if the selected camera is in "live video" mode

2 |Image status (bright light bulb) or a single still image has been
captured.

Displays the name of the camera calibration file for the
currently selected camera.

Displays the type of camera calibration that is in effect for

3 |Camera calibration file

Camera calibration

4 type the currently selected camera, e.g. Camera Only, Robot
Vision, etc.
5 Process execution Indicates the total time required to execute the last Vision
time Process in seconds.

Shows the X/Y position of the mouse cursor in calibrated
Camera coordinates |camera coordinates and the gray-level intensity value of
and intensity reading the associated camera image pixel. This is useful for
setting threshold and edge level values.

Indicates if the currently loaded Vision Project has been
8 |Project modified flag |modified in any way and must be saved to the disk in
order to preserve the changes.

Preferences Panel

The Preferences Panel contains a number of application setup parameters that customize the operation
and appearance of PreciseVision. Once saved, these preferences are automatically reloaded and put
into effect each time the application is restarted.

The Preference Panels appears as shown below.
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F i -

Wigian Graphics] [ ata Logaging ] Live ‘-.-’iu:leu:u] La_l,lcuuts] Ilzer .&ccess] Tool Operatian ]
Ao Start l Envirunment] Camera Hardware] Wweb Interface] Client Settings] .-'-‘-.u:quire]

[ Automnatically load the specified project.

Project File: |

Startup Layout: |Edit Mode ﬂ

I Start PrecizeVision minimized [used for remote support]

[ Start Precizevision locked. Fequires users password o unlock.

| 0 Delay Start. Time in geconds the system will delay before loading. Uszed to
allows PC networking to come online duning auto start, [O=dizable]

Cancel |Jpdate

When any data in the Preferences has been modified, the "Update" button must be pressed before the
change will take effect and be preserved.

In the following table, the configuration information presented on each tab of this panel is briefly
described.

Tab Description

Defines the default disk file path for storing camera images when an
Acquire Acquisition Tool is executed. This is a debugging and diagnostics
convenience for logging images.

Specifies a Vision Project that will be automatically loaded each time
PreciseVision is restarted. Once a Project is loaded, its Vision
Processes are immediately available for execution by a GPL
procedure executing on a Guidance Controller.

This tab also contains the 'Startup Layout' specification. The
specified layout will be automatically loaded each time PreciseVision
is started. For production systems this would normally be set to the
'Run Mode' layout.

Auto Start
Options are also provided to start up PreciseVision minimized and /
or in a locked mode that prevents operators from making changes to
the loaded processes. To set the lock password, see the User
Access tab.

A parameter is provided that will delay PreciseVision from starting
execution for a specified number of seconds. This is beneficial if
PreciseVision is automatically started when the PC boots up, but the
PC requires time to initialized its network cards and camera
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interfaces.

Camera Hardware

Specifies the type of camera hardware to be used to capture
images, e.g. Ethernet or USB, and defines each camera's logical
number. Some of the data specified on this panel and its sub-
panels are specific to the type of camera being employed. Normally,
these parameters are defined during the software and camera
installation process. For more information on this panel, please see
the Camera Installation sections of this manual for detailed
information on configuring each type of supported camera.

Client Settings

Defines the Ethernet IP address for the Guidance Controller that is
accessed during the camera calibration process. For normal
operations, the controller IP address is automatically deduced from
the commands that GPL sends to PreciseVision.

Data Logging

Enables the logging of Vision Tool Results to a disk log file for
diagnostic purposes. Each time a tool is executed, its Results are
time stamped and stored in a specified file in a comma delimited text
format (*.csv). This file can be easily imported to Excel or another
spreadsheet application for analysis.

Also provides a checkbox to enable logging of bi-directional
communications between PreciseVision and Guidance Controllers
and Remote PC Servers. Normally, this should only be enabled for
debugging purposes since it consumes resources.

Environment

Controls whether the Main Toolbar and the Status Bar are
displayed. Also permits adjustment of some diagnostic and
demonstration parameters.

In addition, a checkbox is provided to permit PreciseVision to be
minimized to an icon in the System Tray as opposed to an item on
the Windows Start Bar.

An "Auto Zoom" feature is also provided that automatically scales
the active camera image to best fit within the camera display
window.

Layouts

Defines three user-interface layouts of the dockable panels. These
layouts provide an easy way to quickly switch between several
display formats that are appropriate for different operating needs:
production systems, editing sessions and calibration processes.

If the "Layout Filename" is left blank, PreciseVision will automatically
use a predefined default layout stored in the "Layout" folder of the
installation directory. If the field contains a valid layout file, it will
override these defaults.

Click the "Current" button in each selection to record the size of the
window (width and height) automatically.

Live Video

Controls the rate at which the camera image is updated in Live
Video mode. This permits the Ethernet network traffic to be
balanced when using PreciseVision.

The update rate ranges from 1 to 30 frames per second (fps) with a
default setting of 10. For cameras interfaced at 100Mb Ethernet, a
rate of 1 to 15 fps is typical. For cameras interfaced at 1000Mb
Ethernet, the refresh rate can be as high as 30 fps.
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This mode is NOT available for USB cameras. The frame rate is set
to the maximum defined by the camera. Some USB cameras do not
operate properly if the live frame rate is set to certain values.
Enables and disables the ResultOnNotFound property for all
required tools. This is typically set if an Inspect List Tool is defined
that analyzes the output of a tool that generates multiple results,
such as a Finder, and the Inspect List includes multiple inspection
operations. Enabling this property forces all tools to generate
results even if their inspection tests fail. This is important for
generating complete, consistent sets of results for the Inspect List
to test. This property is normally disabled since most vision
processes prefer to ignore any object that fails an inspection test
This property is disabled by default.

User Access Defines the password used to unlock access to PreciseVision.
Enables and disables the display of Vision Tools and their Results in
the Camera Display Window. Drawing these graphics has relatively
little impact on the performance of the system, so the graphics are
normally displayed.

Enables up to 3 web panels to be configured into the PV user
interface as dockable controls. These panels can be utilized to
integrate web pages of the Guidance Controller into the PV
environment.

Tool Operation

Vision Graphics

Web Interface Either the complete path for each web must be specified, e.g.
"http://192.168.0.1/ROMDISK/web/Opr/master/masterfs.html" or just
the path with the Client Guidance Controller without the Client's IP
address, e.g. 'ROMDISK/web/Opr/master/masterfs.html'. In the
latter case, the IP address of the Client Guidance Controller will be
automatically assumed when displaying the panel.
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Vision Toolkit Introduction

This chapter provides detailed information on each of the tools in the PreciseVision vision
toolkit. These tools perform all of the runtime operations that are needed to acquire and
process an image captured from a camera.

Each instance of a tool is a vision object with a graphical front-end, a property list for
configuring the tool for your desired operation, and a read-only list of results properties
that can be used by other vision objects to create more complex machine vision and
logical operations. The graphical front-ends allow the vision tools to be easily positioned
over a captured image and greatly simplifies their training.

ToolKit Summary

The following table briefly summarizes the primary function of each of the vision tools.
The "Type" broadly categories each tool as to whether it "Acquires” an image, "Finds" an
object, "Measures" features, "Inspects” a region, "Computes" additional information,
"Filters" image or object data or serves as a "Motion Sensor". Please see the detailed
descriptions on the following pages for more ways in which these tools can be utilized.

Vision Tool Type Description

Captures an image from a camera or loads it
Acguisition Tool Acquires from a disk file, and stores the image into a
frame buffer.

Searches a specified region for arc edges and
Arc Fitter Tool Measures returns the arc that best fits the edges. Returns
both the arc center point and radius.

Copies a rectangular area-to-interest to a disk
file, another region of the current image buffer, or
another image buffer. Permits mathematical
manipulation when copying to an image buffer.

Area-Of-Interest (AOI)
Tool

Copies

Reads a variety of standard 1-D and 2-D
Barcode Reader Tool |Inspects barcodes and returns the barcode type and the
value of the barcode.

Verifies that there is no obstruction within the
bounds of a defined window. Typically used to

Clear Grip Tool Inspects confirm that gripping a part will not result in a
collision.
Searches a region for binary blobs and returns

Connectivity Tool Finds the pgntroiq and other features of each bI_ob. In
addition, this tool can return data that defines the
perimeter of any located blob.

Edge Locator Tool Measures Detects edge points with sub-pixel accuracy
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along a linear path in a vision image and returns

their positions. Alternately, this tool can return an
array of the intensities along the linear path or a

histogram of their values.

Find Centerline Tool

Measures

Searches a specified region for edge points and
returns the centerline between two located
bounding lines.

Find Point Tool

Measures

Locates the edge point that is closest to the line
that defines the start of the tool's search region.
The XY position of the point is returned with sub-
pixel accuracy along (and pixel accuracy
perpendicular to) the search direction.

Finder Tool

Finds

Most powerful vision tool that identifies randomly
placed parts in a camera image and returns their
position, orientation and scaling to within sub-
pixel accuracy.

Fixed Frame Tool

Computes

Places a reference frame at a fixed image
coordinate or at a constant offset relative to
another vision object. Can optionally index the
frame in an X and/or Y grid pattern to repeatedly
execute any linked tools.

Image Process Tool

Enhances
image

Performs image filtering, edge extraction,
thresholding and morphological operations on a
specified area in the camera image.

Inspect Frame Tool

Computes

Passes through the XPos, YPos and Angle
Results of a referenced tool and optionally
rotates and shifts the Results based upon an
inspection. The inspection can consist of the
arithmetic combination of the Results of two
other tools. So, this tool also provides a means
for performing simple mathematical operations
on the results of two tools.

Inspect List Tool

Computes

Passes through the XPos, YPos and Angle
Results of a referenced tool and tests up to 12
different Results from multiple tools to determine
if the object is good or bad. This tool provides a
convenient way to perform complex testing of a
located object and generating an equivalent
location with a single Pass/Fail indicator.

Inspect Region Tool

Computes

Inspects the perimeter and the interior of an
opaque object to determine if there are any flaws
in the object's outline or holes in the interior.
This tool was designed to inspect wafers, where
slight changes in the overall size and shape of
the wafer are permitted, but chips in the
perimeter or interior holes or cracks are
unacceptable.

Light Recorder Tool

Detects light

Acquires a sequence of camera images for a
specified period of time, determines the

pattern brightness of each image, and returns the
brightness readings.
: . Searches a specified region for edge points and
Line Fitter Tool Measures returns the line that best fits the edges.
Line-Line Frame Tool |Computes Determines the intersection of two lines defined

67



PreciseVision

68

by vision objects and returns a reference frame.
Alternately, computes and returns the midpoint of
two reference frames defined by two vision
objects.

Pixel Window Tool

Inspects

Counts edges or binary pixels or collects gray-
scale statistics within a rotated rectangular or
circular region. Used for quickly detecting the
presence of features or collecting general
intensity information about a region.

Pixel Color Window
Tool

Inspects

Tests if the general RGB color of a rectangular or
circular region matches a trained color within a
specified tolerance. Also computes the mean
HSV/HSI values for the region.

Point-Line Frame Tool

Computes

Takes a point and a line from two vision objects
and returns a reference frame.

Point-Point Line Tool

Computes

Computes a line given two points from vision
objects.

Sensor Window Tool

Detects
motion

Detects motion in a window region. Ensures the
scene is stable prior to other operations or waits
until motion is detected. Can be used in place of
physical sensors in flexible parts feeding where

parts can take time to settle.

Text Label Tool

Labels

Displays string constants plus inspection and
results data from a referenced tool. Textis
shown relative to the position of the referenced
tool.

Tool Filter Tool

Filters

Takes the output from another tool that
generates multiple sets of results, and returns a
subset of the results based upon specified

criteria.

Standard Tool Properties

To simplify their application, as much as practical, the vision tools make use of a common
group of property names and associated operations. The following tables describe the
standard tool properties that are common to many of the tools.

In these tables and the detailed tool descriptions, properties that are "read-only" have
their name and data type dimmed. In addition, properties that have a counterpart
property or method within the Guidance Programming Language include the GPL
member name underlined and in italics bounded by square brackets preceded by "GPL:"
and the class name, e.g. "[GPL: Vision.ResultCount]".

The Identity Properties specify the name of the tool and its basic tool type.

1. Standard Identity Properties

Property Data A
Name Type Range Description
This is the unique name that must be
Name String n/a assigned to each instance (copy) of a
general tool type. The name must follow
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the GPL variable naming conventions.
That is, a name can be mixed case
(upper and lower case characters) but
when referenced by other tools, the
names are not considered case sensitive
(i.e. Abc and aBc refer to the same tool).
Names must start with either a letter or an
underscore "_" and can be followed by up
to 127 additional letters, numbers and
underscores. In GPL, this is the name by
which a tool is referenced.

Type

String

n/a

This read-only property displays the basic
type for the tool, e.g. VsLineFitter.

The Placement / Size Properties define the position, orientation and size of the tool in
the coordinate system of the camera. In addition, if the tool is defined relative to another
tool, the relative position and orientation can also be specified. Normally, it is easiest to
graphically position and size each tool by dragging on the tool's handles displayed in the
Camera Display Window. In the range specifications, "AOI" is an abbreviation for "Area
of Interest” and refers to the size of the portion of the camera image that is being

analyzed.
2. Standard Placement/Size Properties
P:\j);)rﬁ:y 1'?;;2 Range Description

Angle Single -360 to 360 These values specify the orientation (in

XPOS Single 0 - AOI (mm) degrees) and the position (in calibrated
units, mm) of the center of the vision tool
in the coordinates of the vision image.
These values are automatically updated

YPoS Single 0 - AOI (mm) when the tool is graphically re-positioned
and re-oriented during training and if the
vision tool is placed relative to another
vision tool during runtime.

Height Single 0 - AOI (mm) |These values define the height and width
of the vision tool in calibrated units (mm).
These values are automatically updated

Width Single 0- AOI (mm) |when the tool is adjusted with the mouse
or can be manually entered for more
precise adjustments.

RelAngle Single -360 to 360 These values specify the orientation (in

RelXPos Single 0 - AOI (mm) degrees) and the position (in calibrated
units, mm) of the center of the vision tool
relative to the vision object specified by

RelYPos Single 0 - AOI (mm) RelativeToolName. If the vision tool is
not relative to another vision object, these
values are zero.

The Operation Properties define parameters that control the execution of the tool. For
example, a tool might have an Operation Property that defines if it should screen out
black-to-white edges or the gray scale levels above which pixels are processed. Only the
commonly used Operation Properties are placed in this group.
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3. Standard Operation Properties

Property Data -
Name Type Range Description
Defines the number of the camera (and
Camera Integer 1-6 its associated frame buffer) on which the
tool operates.
If a tool is to be positioned relative to
another tool, this is the name of the
. referenced tool. Tools can be relative to
Relative- . L o
List n/a any vision tool that returns a vision
ToolName . o
coordinate position. By default tools are
not relative to another tool and this
property is blank.

The Advanced Operation Properties contain Operation Properties that are not normally
modified and generally require a bit more experience to utilize. For these properties, their
default settings will yield good tool performance for typical applications.

3A. Standard Advanced Operation Properties

Property Data
Name Type

Range

Description

The Inspection Settings Properties permits a single scalar result of the vision tool to be
automatically tested (inspected) to verify that it is within limits. A Pass / Fail property is
set accordingly and a Pass / Fail label can be optionally displayed on the tool in the

Camera Display Window.

4. Standard Inspection Settings Properties

Property Data
Name Type

Range

Description

InspectType List

Specifies the single scalar result that is
to be inspected. The items in the list
vary from one tool to the next. Select
"None" to disable inspecting a result.

InspectLabel List

NONE /
PASS_AND_FAIL /
PASS / FAIL /
VALUE_REAL /
VALUE_INTEGER

Indicates if a Pass / Fail label or a
numeric value is to be displayed on the
tool in the Camera Display Window
based upon the results of the
inspection. The items in the list
indicate if no label should be
displayed, only a Pass label, only a
Fail label, either a Pass or Fail label, or
a real or integer numeric value. The
Pass indicator is displayed in green
and the Fail is written in red. This
selection is used for display purposes
only and has no effect on the results of
the inspection.

InspectMax Single

Maximum and minimum values




InspectMin Single
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permitted for the item specified in
InspectType to "Pass" the inspection.
Values outside of this range are
marked as "Failed".

InspectActual | Single

This is a read-only property that
indicates the value of the result
specified by InspectType that was
tested during the inspection. [GPL:
VisResult.InspectActual]

InspectPassed | List

Pass / Fall

Indicates if the inspection criteria was
satisfied (Pass) or was not (Fail). Set
to 'Pass' if no inspection is selected. If
the inspection fails, any tool that
references this tool, for example via
the RelativeToolName property, will
also have a failed InspectPassed
although that tool will still be evaluated.
[GPL: VisResult.InspectPassed]

The Results Settings Properties control the results that are computed by the vision
tool. For example, if multiple sets of results can be computed by the tool, these
properties can limit the number of sets of data computed and can select the set of data
that is displayed in the Results Properties.

5. Standard Results Settings Properties

Property Name

Data
Type

Range

Description

MaxResults

Integer

-lorlton

For tools that provide multiple sets of
results, this property can limit the
maximum number of sets of results
that are computed and returned. A
negative 1 (-1) indicates that all
possible results should be collected.

OffsetAngle

Single

degrees

OffsetX

Single

mm

OffsetY

Single

mm

These Offset values permit the results
of a vision tool to be shifted and rotated
from their standard location. This
allows you to re-position the results of
a tool to a position and orientation that
is more meaningful to you. The
orientation change is in degrees and
the shift is in calibrated units (mm).
See the Fixed Frame Tool for an
alternate method for implementing this
offset.

ResultOnNotFound |Boolean

TRUE/
FALSE

If TRUE, indicates that the "Return
results if not found" Preferences
property is asserted. Normally, this
property is FALSE and only tools that
are successful will generate results and
continue processing an object. This is
the correct behavior if you only wish to
process objects that pass all inspection
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tests. However, if a tool is referenced
in an Inspect List, it is important that
both successful and failed results be
returned so that all of the inspections in
the list are aligned and are with respect
to the same located object. So, if an
Inspect List is being utilized, this
Preference property should be set to
TRUE.

For tools that return more than one set
of results, this property selects the set

ResultSelect Integer 1-n of results that is displayed in the
Results Properties. This does not
affect the actual results of the tool.
Alters how the results of a tool is
graphically displayed. Each vision tool
has a default method for display, e.g. a
line or a frame. This property allows

NONE / |the graphical display to be changed.
. POINT/  |For example, a Fixed Frame Tool is

ShowResults List .

LINE / normally displayed as a reference
FRAME |frame. However, if it is being used as

a datum line or a point, its display can
be changed to a line or a point for
visual clarity. This property does not
affect the actual results of the tool.

The Results Properties display a single set of results for the vision tool. In general, the
results returned varies from tool to tool. Many tools return a vision reference frame.
However, some tools return additional results items such as statistical information on how
well the answer fits the actual data. If the tool computes more than one set of results and
MaxResults is set to greater than 1, the displayed set of results will correspond to the
setting of the ResultSelect property.

6. Results Properties

Property Name

Data
Type

Range

Description

ResultCount

Integer

Number of sets of results the vision tool
has returned. [GPL: Vision.ResultCount]

ResultErrorCode

Integer

Standard error code that indicates if the
tool executed without an error. This is
different from the InspectPassed,
which indicates if the result was
computed properly but its value was
inside or outside of a specified limit. If
ResultErrorCode is non-zero, any tool
that references this tool, for example via
the RelativeToolName property, will
also fail with this same error code and
will not be evaluated. [GPL.:
VisResult.ErrorCode]

ResultAngle

Single

-360 to 360

Orientation (in degrees) and position (in




ResultXPos

Single

mm

ResultYPos

Single

mm
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calibrated units, mm) of the center of
the results computed by the vision tool
in the coordinates of the vision image
taking into consideration the value of
the Offset's in the Results Settings
Properties. For robot guidance
applications, these values are
transformed by the vision-to-robot
calibration conversion routines and then
presented as [GPL: VisResult.Loc.X,
VisResult.Loc.Y and
VisResult.Loc.Roll].
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Acquisition Tool

Vision tool that captures an image from a camera or loads it from a disk file, and
stores the image into a frame buffer.

Prerequisites

None
Properties
Property Name DEIES Range Description
Type
1. Identity
Name Strin n/a . .
N9 Standard Identity properties

Type String n/a

3. Operation

Camera Integer 1-6 Standard Operation property

GainBlue Single These properties scale the intensity

GainGreen Single |0-12 (set to -1 if not a color values for each of the three color

camera) layers as they are read from the

GainRed Single camera. This permits the color
intensities to be balanced.

3A. Advanced Operation
If True, a copy of the image is stored
into a secondary buffer when the
image is acquired. This must be set
True if the original image is to be
restored by a subsequent Acquisition

AcquireBuffer- Boolean True / False tool that has its AcquireMode set to

Image "RESTORE_ORIGINAL". For
resolutions greater than 640x480,
setting this value to False, if not
needed, can save a few milliseconds
of execution time. Set False by
default.
If this tool is set to automatically save
a camera image to a disk file, this
property specifies whether the image
should be saved as a non-

Acquire-Extension List BMP / PNG compressed bitmap (BMP) or as a

compressed image in a lossless
format (PNG). The PNG file format is
smaller, but requires more CPU time
to create.
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AcquireFill-
GraylLevel

Integer

0-255

If the AcquireMode is defined as
"CLEAR_BUFFER?", all of the pixels in
the image buffer are set to the
intensity value specified by this

property.

AcquireMax-
CurrentCount

Integer

0 - 99999

AcquireMax-
Savelmages

Integer

-1-99999

When the AcquireMode is set to
ACQUIRE_AND_SAVE or
SAVE_ONLY, the
AcquireMaxSavelmages property
defines the largest index that is
appended to the AcquirePrefix to
generate the name of the file in which
the image is stored.

If AcquireMaxSavelmages is -1, the
next highest unused index values is
assigned up to the maximum value of
99999. So, existing image files will
not be over-written.

If AcquireMaxSavelmages is set >0,
AcquireMaxCurrentCount will
indicate the next index. When the limit
specified by
AcquireMaxSavelmages is reached,
AcquireMaxCurrentCount is
automatically reset to 0. This permits
the last AcquireMaxSavelmages
files to be saved without consuming
more and more disk space (but
existing image files will be over-
written). In this mode of operation,
AcquireMaxCurrentCount can be
manually changed or automatically
altered by a robot control program to
reset the next index to a specific
value. The value of
AcquireMaxCurrentCount is not
stored with the vision project and is
reset to 0 each time the vision project
is loaded.

AcquireMode

List

NORMAL_ACQUIRE /
ACQUIRE_AND_SAVE /
CLEAR_BUFFER/
PLAY_FROM_DISK /
LIVE_VIDEO /
SAVE_ONLY /
RESTORE_ORIGINAL

"NORMAL_ACQUIRE" - acquires a
single image from the specified
camera and places it into a frame
buffer.

"ACQUIRE_AND_SAVE" - performs
the same operation as
"NORMAL_ACQUIRE" and then
saves the image to a disk file.

"CLEAR_BUFFER" - Sets all of the
pixels in a buffer to the intensity value
specified by AcquireFillGrayLevel.
This is useful before an AOI copy is
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performed.

"PLAY_FROM_DISK" - restores an
image from a disk file. The disk file is
specified by the AcquirePath and
AcquirePrefix (see below). If there
are multiple numbered image files
with the same prefix, each time the
Vision Process is executed, the
contents of the next sequential file will
be copied to the image buffer.

"LIVE_VIDEO" - continuously updates
the vision display with the latest
image from the camera. This is a
system setup mode that facilitates
setting the camera f-stop, focus,
VideoGain, and VideoOffset.

"SAVE_ONLY" - stores the contents
of the current frame buffer to a disk
file. This enables a GPL program to
execute a vision process that saves
selected frame buffers for later
access.

"RESTORE_ORIGINAL" - restores
the contents of the current frame
buffer to its original value at the time
that the image was first captured.
Requires that AcquireBufferimage is
set to True when the image is first
captured.

AcquirePath

String

n/a

String that defines the path to the disk
file when AcquireMode is set to
"ACQUIRE_AND_SAVE" or
"PLAY_FROM_DISK". If blank ("),
the path defined in the Preferences
will be used. If the path does not
containa ' (i.e. C:\...), AcquirePath
will be appended to the path where
the PreciseVision application is
stored, e.g. "C:\Program Files\Precise
Automation\PreciseVision #.#\"

AcquirePrefix

String

n/a

String that defines the disk file name
(excluding the required .BMP
extension) when AcquireMode is set
to "ACQUIRE_AND_SAVE" or
"PLAY_FROM_DISK". If blank ("),
the file name defined in the
Preferences will be used. This string
is combined with AcquirePath, a
numerical index, and the ".BMP" file
extension to generate the disk file
name for saving or loading vision
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images.

ActivelLayer

List

Monochrome / RedLayer /
GreenLayer / BlueLayer

Specifies the type of data to be
loaded into the image frame buffer for
processing by subsequent vision
tools.

For grayscale cameras, only
"Monochrome" image buffers are
available and each pixel in the frame
buffer has a value from 0 to 255 that
defines its grayscale intensity.

For color cameras, the frame buffer
can be loaded with one of four types
of data: monochrome, red, green or
blue. The monochrome mode
produces the same results as a
grayscale camera. The red, green and
blue modes load the intensity data for
a single color. For example, if
"RedLayer" is selected, the image
frame buffer will contain values that
indicate the intensity (response) of
only the red receptors of the camera.
Tools that are applied to this image
will only be operating on the red color
layer of the camera. The one
exception is the "Pixel C